Cyber-shot Handbooks
DSC-T90/T900
How to use this handbook

Click on a button at upper right to jump to the corresponding page. This is convenient when searching for a function you want to view.

Search for information by function.

Search for information by operation.

Search for information in a listing of HOME/MENU items.

Search for information by keyword.

Marks and notations used in this handbook

In this handbook, the sequence of operations is shown by arrows (→). You should touch the items on the screen in the order indicated. Marks are shown as they appear in the camera’s default setting.

The default setting is indicated by  ✔.

Indicates cautions and limitations relevant to the correct operation of the camera.

Indicates information that is useful to know.
Notes on using the camera

Notes on the types of “Memory Stick” media that you can use (sold separately)

“Memory Stick Duo” media: You can use a “Memory Stick Duo” media with the camera.

“Memory Stick” media: You cannot use a “Memory Stick” media with the camera.

Other memory cards cannot be used.

- For details on “Memory Stick Duo” media, see page 163.

When using a “Memory Stick Duo” media with “Memory Stick” media compatible equipment

You can use the “Memory Stick Duo” media by inserting it into the “Memory Stick Duo” media Adaptor (sold separately).

Notes on the battery pack

- Charge the battery pack (supplied) before using the camera for the first time.
- You can charge the battery pack even if it is not completely discharged. In addition, even if the battery pack is not fully charged, you can use the partially charged capacity of the battery pack as is.
- If you do not intend to use the battery pack for a long time, use up the existing charge and remove it from the camera, then store it in a cool, dry place. This is to maintain the battery pack functions.
- For details on the usable battery pack, see page 165.

Carl Zeiss lens

The camera is equipped with a Carl Zeiss lens which is capable of reproducing sharp images with excellent contrast.

The lens for the camera has been produced under a quality assurance system certified by Carl Zeiss in accordance with the quality standards of Carl Zeiss in Germany.

Notes on the LCD screen and lens

- The LCD screen is manufactured using extremely high-precision technology so over 99.99% of the pixels are operational for effective use. However, some tiny black and/or bright dots (white, red, blue or green) may appear on the LCD screen. These dots are a normal result of the manufacturing process and do not affect the recording.

- If water droplets or other liquids splash on the LCD screen and make it wet, immediately wipe off the screen with a soft cloth. Leaving liquids on the LCD screen surface can harm the quality and cause a malfunction.
- Exposing the LCD screen or the lens to direct sunlight for long periods may cause malfunctions. Be careful when placing the camera near a window or outdoors.
- Do not press against the LCD screen. The screen may be discolored and that may cause a malfunction.
- Images may trail across on the LCD screen in a cold location. This is not a malfunction.
- Be careful not to bump the lens, and be careful not to apply force to it.

The images used in this Handbook

The images used as examples in this Handbook are reproduced images, and are not actual images shot using this camera.

On Illustrations

Illustrations used in this Handbook are of the DSC-T900 unless noted otherwise.
# Table of contents

## Notes on using the camera

- How to use this handbook ........................................... 2
- Notes on using the camera .......................................... 3
- Operation Search ...................................................... 7
- HOME/MENU Search ................................................ 10
- Identifying parts (DSC-T900) ...................................... 14
- Identifying parts (DSC-T90) ........................................ 15
- Using the touch panel ............................................... 16
- Changing the DISP (screen display) setting ................. 17
- Using the internal memory ......................................... 19

## Shooting

- Intelligent Auto Adjustment ................................. 20
- Scene Selection ..................................................... 21
- Easy Shooting ....................................................... 23
- Program Auto ....................................................... 24
- Movie Mode .......................................................... 25
- Movie shooting mode ............................................ 26
- Smile Shutter ........................................................ 27
- Zoom ................................................................. 28
- Self-Timer ............................................................. 29
- Macro/Close focus ............................................... 30
- Flash ................................................................. 31
- Focus ............................................................... 32
- Metering Mode ..................................................... 34
- ISO ................................................................. 35
- EV ................................................................. 36
# Viewing

- Viewing still images ........................................... 38
- Playback Zoom .................................................. 39
- Image Index ....................................................... 40
- Slideshow ......................................................... 41
- Delete ............................................................ 43
- Wide Zoom ....................................................... 44
- Temporarily Rotated Display .............................. 45
- Viewing movies .................................................. 46

# HOME

- HOME items ..................................................... 10

# MENU (Shooting)

- MENU items (Shooting) ................................. 12

# MENU (Viewing)

- MENU items (Viewing) ................................. 13

# TV

- Viewing an image on a SD TV (DSC-T900) ...... 121
- Viewing an image on an HD TV (DSC-T900) .... 122
- Viewing an image on a SD TV (DSC-T90) ...... 127
- Viewing an image on an HD TV (DSC-T90) ...... 128
Computer

Enjoying your Windows computer .......................... 130
Installing the software (supplied) ......................... 132
On “PMB (Picture Motion Browser)” ....................... 133
Enjoying images on your computer ....................... 134
Using the “Music Transfer” (supplied) ..................... 138
Using your Macintosh computer ......................... 139
Viewing “Cyber-shot Step-up Guide” ..................... 142

Printing

Printing still images ........................................... 143
Printing images directly using a PictBridge compliant printer .................. 144
Printing at a shop ............................................ 146

Troubleshooting

Troubleshooting ................................................ 147
Warning indicators and messages ...................... 157

Others

Using the camera abroad — Power sources .......... 162
On the “Memory Stick Duo” media ....................... 163
On the battery pack ........................................ 165
On the battery charger ..................................... 166

Index

Index .............................................................. 167
# Operation Search

<table>
<thead>
<tr>
<th>Section</th>
<th>Feature</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Leaving the settings to the camera</td>
<td>Intelligent Auto Adjustment</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Scene Selection</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td>Scene Recognition</td>
<td>90</td>
</tr>
<tr>
<td>Shooting portraits</td>
<td>Soft Snap</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td>Twilight Portrait</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td>Smile Shutter</td>
<td>27</td>
</tr>
<tr>
<td></td>
<td>Scene Recognition</td>
<td>90</td>
</tr>
<tr>
<td></td>
<td>Face Detection</td>
<td>93</td>
</tr>
<tr>
<td></td>
<td>Anti Blink</td>
<td>96</td>
</tr>
<tr>
<td></td>
<td>Red Eye Reduction</td>
<td>97</td>
</tr>
<tr>
<td>Shooting food arrangements</td>
<td>Gourmet</td>
<td>21</td>
</tr>
<tr>
<td>Shooting close to objects</td>
<td>Macro</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td>Close focus enabled</td>
<td>30</td>
</tr>
<tr>
<td>Shooting moving objects</td>
<td>Hi-Speed Shutter</td>
<td>22</td>
</tr>
<tr>
<td></td>
<td>Movie Mode</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td>Burst</td>
<td>81</td>
</tr>
<tr>
<td>Shooting without blur</td>
<td>High Sensitivity</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td>Hi-Speed Shutter</td>
<td>22</td>
</tr>
<tr>
<td></td>
<td>2-second delay self-timer</td>
<td>29</td>
</tr>
<tr>
<td></td>
<td>ISO</td>
<td>35, 84</td>
</tr>
<tr>
<td></td>
<td>SteadyShot</td>
<td>100</td>
</tr>
<tr>
<td>Shooting with backlight</td>
<td>Forced Flash</td>
<td>31</td>
</tr>
<tr>
<td></td>
<td>Scene Recognition</td>
<td>90</td>
</tr>
<tr>
<td></td>
<td>DRO</td>
<td>98</td>
</tr>
<tr>
<td>Table of contents</td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Shooting in dark places</td>
<td>High Sensitivity ...................................................... 21</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slow Synchro (Flash On) ............................................... 31</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ISO ............................................................................ 35, 84</td>
<td></td>
</tr>
<tr>
<td>Adjusting exposure</td>
<td>Histogram .................................................................... 18</td>
<td></td>
</tr>
<tr>
<td></td>
<td>EV ............................................................................. 36, 83</td>
<td></td>
</tr>
<tr>
<td>Changing focus</td>
<td>Using the touch panel .................................................. 16</td>
<td></td>
</tr>
<tr>
<td>position</td>
<td>Focus .......................................................................... 32, 88</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Face Detection ............................................................. 93</td>
<td></td>
</tr>
<tr>
<td>Changing image size</td>
<td>Image Size .................................................................. 78</td>
<td></td>
</tr>
<tr>
<td>Deleting images</td>
<td>Delete .......................................................................... 43, 114</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Format .......................................................................... 53</td>
<td></td>
</tr>
<tr>
<td>Displaying enlarged</td>
<td>Playback zoom ................................................................ 39</td>
<td></td>
</tr>
<tr>
<td>images</td>
<td>Trimming ........................................................................ 110</td>
<td></td>
</tr>
<tr>
<td>Displaying full-screen</td>
<td>DISP (Screen Display) .................................................. 17</td>
<td></td>
</tr>
<tr>
<td>images</td>
<td>Wide Zoom .................................................................... 18, 44</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Temporarily Rotated Display .......................................... 45</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Image Size .................................................................... 78</td>
<td></td>
</tr>
<tr>
<td>Editing images</td>
<td>Retouch ......................................................................... 110</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Paint ............................................................................. 112</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Multi-Purpose Resize .................................................... 113</td>
<td></td>
</tr>
<tr>
<td>Playing back a series</td>
<td>Slideshow ..................................................................... 41</td>
<td></td>
</tr>
<tr>
<td>of images in order</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shooting with easy-to-</td>
<td>Easy Shooting ................................................................ 23</td>
<td></td>
</tr>
<tr>
<td>see indicators</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Printing images with</td>
<td>On “PMB (Picture Motion Browser)” .................................. 133</td>
<td></td>
</tr>
<tr>
<td>the date</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
<td></td>
</tr>
<tr>
<td>------------------------------------</td>
<td>------</td>
<td></td>
</tr>
<tr>
<td>Changing date and time settings</td>
<td>76</td>
<td></td>
</tr>
<tr>
<td>Initializing settings</td>
<td>61</td>
<td></td>
</tr>
<tr>
<td>Printing images</td>
<td>143</td>
<td></td>
</tr>
<tr>
<td>Viewing on TVs</td>
<td>121, 127, 122, 128</td>
<td></td>
</tr>
<tr>
<td>Information about optional accessories</td>
<td>142</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
HOME/MENU Search

HOME items

On the HOME screen, camera operations are organized for convenience into broad categories for selection, such as shooting, viewing and printing images.

1 Touch HOME to display the HOME screen.

2 Touch the desired category → desired item → OK.

Press the shutter button halfway down to return to shooting mode.

Click on an item under “Items” in the table below to jump to the corresponding page.

<table>
<thead>
<tr>
<th>Category</th>
<th>Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>📸 Shooting</td>
<td>Shooting</td>
</tr>
<tr>
<td>🎥 View Images</td>
<td>Date View*</td>
</tr>
<tr>
<td></td>
<td>Event View*</td>
</tr>
<tr>
<td></td>
<td>Favorites*</td>
</tr>
<tr>
<td></td>
<td>Folder View</td>
</tr>
<tr>
<td>🎥 Slideshow</td>
<td>Slideshow</td>
</tr>
<tr>
<td></td>
<td>Music Tool</td>
</tr>
<tr>
<td></td>
<td>Download Music</td>
</tr>
<tr>
<td></td>
<td>Format Music</td>
</tr>
<tr>
<td>📅 Print</td>
<td>Print</td>
</tr>
<tr>
<td>🗑️ Manage Memory</td>
<td>Memory Tool</td>
</tr>
<tr>
<td></td>
<td>“Memory Stick” Tool*</td>
</tr>
<tr>
<td></td>
<td>Format</td>
</tr>
<tr>
<td></td>
<td>Create REC.Folder</td>
</tr>
<tr>
<td></td>
<td>Change REC.Folder</td>
</tr>
<tr>
<td></td>
<td>Delete REC.Folder</td>
</tr>
<tr>
<td></td>
<td>Copy</td>
</tr>
<tr>
<td></td>
<td>File Number</td>
</tr>
<tr>
<td></td>
<td>Memory Tool</td>
</tr>
<tr>
<td></td>
<td>“Internal Memory Tool”</td>
</tr>
<tr>
<td></td>
<td>Format</td>
</tr>
<tr>
<td></td>
<td>File Number</td>
</tr>
</tbody>
</table>

Continued ↓
<table>
<thead>
<tr>
<th>Category</th>
<th>Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settings</td>
<td>Main Settings &lt;br&gt;– Main Settings 1 &lt;br&gt;Beep &lt;br&gt;Function Guide &lt;br&gt;Initialize &lt;br&gt;Calibration &lt;br&gt;Housing &lt;br&gt;Mode Demo</td>
</tr>
<tr>
<td></td>
<td>Main Settings &lt;br&gt;– Main Settings 2 &lt;br&gt;HDMI Resolution (DSC-T900 only) &lt;br&gt;CTRL FOR HDMI (DSC-T900 only) &lt;br&gt;COMPONENT &lt;br&gt;Video Out &lt;br&gt;TV TYPE &lt;br&gt;USB Connect</td>
</tr>
<tr>
<td></td>
<td>Shooting Settings &lt;br&gt;– Shooting Settings 1 &lt;br&gt;AF Illuminator &lt;br&gt;Grid Line &lt;br&gt;Digital Zoom</td>
</tr>
<tr>
<td></td>
<td>Shooting Settings &lt;br&gt;– Shooting Settings 2 &lt;br&gt;Auto Orientation &lt;br&gt;Auto Review</td>
</tr>
<tr>
<td></td>
<td>Clock Settings &lt;br&gt;Language Setting</td>
</tr>
</tbody>
</table>

* These items are displayed only when a “Memory Stick Duo” media is inserted into the camera.

**Notes**

- Only the available items are displayed on the screen.
- You cannot display the HOME screen when a PictBridge connection or a USB connection is made.
Here the functions that can be used on the screen that appears in shooting mode are displayed for easy setting.

1. Lower the lens cover to switch to shooting mode.
2. Touch **MENU** to display the Menu screen.

3. Touch the menu item → desired mode → **OK**.
   - **X** appears when the desired item is already selected.

In the table below, ✓ indicates a function is available and — that it is unavailable. The icons below [Scene Selection] indicate the available Scene Selection modes. Click on an item under “Menu items” to jump to the corresponding page.

<table>
<thead>
<tr>
<th>Menu items</th>
<th>AUTO</th>
<th>PGM</th>
<th>Scene Selection</th>
<th>EASY</th>
</tr>
</thead>
<tbody>
<tr>
<td>REC Mode</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Image Size</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Flash</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>REC Mode</td>
<td>✓</td>
<td>✓</td>
<td>🏊‍♂️ 🏊♂️ 🏊‍♀️ 🏊♀️</td>
<td>—</td>
</tr>
<tr>
<td>EV</td>
<td>✓</td>
<td>—</td>
<td>✓</td>
<td>—</td>
</tr>
<tr>
<td>ISO</td>
<td>—</td>
<td>—</td>
<td>🐟</td>
<td>—</td>
</tr>
<tr>
<td>White Balance</td>
<td>—</td>
<td>✓</td>
<td>📸 📸</td>
<td>—</td>
</tr>
<tr>
<td>Underwater White Balance</td>
<td>—</td>
<td>—</td>
<td>🐟</td>
<td>—</td>
</tr>
<tr>
<td>Focus</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Metering Mode</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Scene Recognition</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Smile Detection Sensitivity</td>
<td>✓</td>
<td>✓</td>
<td>📸 📸</td>
<td>—</td>
</tr>
<tr>
<td>Face Detection</td>
<td>✓</td>
<td>✓</td>
<td>📸 📸</td>
<td>—</td>
</tr>
<tr>
<td>Flash Level</td>
<td>—</td>
<td>✓</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Anti Blink</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Red Eye Reduction</td>
<td>✓</td>
<td>✓</td>
<td>📸 📸</td>
<td>—</td>
</tr>
<tr>
<td>DRO</td>
<td>—</td>
<td>✓</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Color Mode</td>
<td>—</td>
<td>✓</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>SteadyShot</td>
<td>—</td>
<td>✓</td>
<td>🐟</td>
<td>—</td>
</tr>
<tr>
<td>Shooting Settings</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

**Note**
- Only the items that are available for each mode are displayed on the screen.
Here the functions that can be used on the screen that appears in view mode are displayed for easy setting.

1 Press the  (Playback) button to switch to playback mode.

2 Touch MENU to display the Menu screen.

3 Touch the menu item → desired mode → [OK].  appears when the desired item is already selected.

In the table below, ✓ indicates a function is available and — that it is unavailable. Click on an item under “Menu items” to jump to the corresponding page.

<table>
<thead>
<tr>
<th>MENU items</th>
<th>View Mode</th>
<th>“Memory Stick Duo” media</th>
<th>Internal Memory</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Date View</td>
<td>Event View</td>
<td>Favorites</td>
</tr>
<tr>
<td>(Date List)</td>
<td>✓</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>(Event List)</td>
<td>—</td>
<td>✓</td>
<td>—</td>
</tr>
<tr>
<td>(Select Folder)</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>(View Mode)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>(Filter by Faces)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>(Slideshow)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>(Add / Remove Favorites)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>(Retouch)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>(Paint)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>(Multi-Purpose Resize)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>(Delete)</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
</tr>
<tr>
<td>(Protect)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>DPOF</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>(Print)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>(Rotate)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>(Volume Settings)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

Note
- Only the items that are available for each mode are displayed on the screen.
Identifying parts (DSC-T900)

**Camera**

1. Shutter button
2. Speaker
3. Zoom (W/T) lever (28, 39)
4. Microphone
5. ON/OFF (Power) button
6. Flash
7. Self-timer lamp/Smile Shutter lamp/AF illuminator
8. Lens
9. Lens cover
10. LCD screen/Touch panel
11. (Playback) button (38)
12. Mode switch
13. Hook for wrist strap/Grip
14. Battery eject lever
15. Battery insertion slot
16. Tripod receptacle
17. Multi Connector
18. Battery/“Memory Stick Duo” media cover
19. Access lamp
20. “Memory Stick Duo” media slot
21. Camera connector terminal
22. DC IN jack
23. USB jack
24. HDMI jack
25. A/V OUT (STEREO) jack

**Multi-output stand**
Identifying parts (DSC-T90)

1. Zoom (W/T) lever (28, 39)
2. Shutter button
3. Microphone
4. ON/OFF (Power) button
5. Flash
6. Self-timer lamp/Smile Shutter lamp/AF illuminator
7. Lens
8. Lens cover
9. LCD screen/Touch panel
10. (Playback) button (38)
11. Hook for wrist strap/Grip
12. Speaker
13. Battery/“Memory Stick Duo” media cover
14. Tripod receptacle
15. Battery eject lever
16. Access lamp
17. “Memory Stick Duo” media slot
18. Battery insertion slot
19. Multi Connector
Using the touch panel

You can make function settings on the camera by touching buttons displayed on the screen.

<table>
<thead>
<tr>
<th>OK</th>
<th>Advances to the next screen.</th>
</tr>
</thead>
<tbody>
<tr>
<td>BACK</td>
<td>Return to the previous screen.</td>
</tr>
<tr>
<td>X</td>
<td>Return to the shooting/playback mode.</td>
</tr>
<tr>
<td>OFF</td>
<td>Set the screen display in playback mode to [Image Only].</td>
</tr>
<tr>
<td>▲/▼/◄/►</td>
<td>Display the hidden items so that the items you want to set are shown on the screen.</td>
</tr>
</tbody>
</table>

**Notes**

- To operate the touch panel, press it lightly with your finger or the supplied paint pen. Pressing excessively hard or using a pointed object other than the supplied paint pen could damage the touch panel.
- If you touch the top right of the screen during shooting, the buttons and icons will momentarily disappear. The buttons and icons will reappear when you take your finger off the screen.

**Touching the screen to set the focus**

Touching the subject on the touch panel displays a frame, and then pressing the shutter button halfway down brings the frame into focus. If there is a face in the frame, in addition to the focus, the brightness and hue are also automatically optimized.

| > Face is detected at the touched position. |
| < Object other than a person’s face is detected. |
| OFF Cancel the function. |

**Notes**

- You cannot use this function when using the digital zoom, shooting in (Close focus enabled) mode or in EASY (Easy Shooting) mode.
- You cannot use this function when (Landscape), (Twilight), (Gourmet), (Fireworks) or (Underwater) mode is selected in the Scene Selection.
Changing the DISP (screen display) setting

Touch DISP on the screen to change to the display selection screen.

**Note**
- Settings other than [Brightness] should be made separately for shooting and playback.

### Display Setup

This sets whether or not to display the operation buttons and icons on the screen.

<table>
<thead>
<tr>
<th>(Normal)</th>
<th>The operation buttons and the icons are displayed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Simple)</td>
<td>Only the operation buttons are displayed.</td>
</tr>
<tr>
<td>(Image Only)</td>
<td>The operation buttons and the icons are not displayed.</td>
</tr>
</tbody>
</table>

#### Using [Image Only] playback

- Select an image by touching the left and right sides of the screen. When you touch the center of the screen, [Normal] display mode is selected temporarily. Touch Off on the upper right corner of the screen to return to [Image Only] display mode.
- In [Normal] or [Simple] display mode, touch Off to switch to [Image Only] display. Touch the center of the screen to return to the previous display mode.
Wide Zoom

In single-image mode, still images at a 4:3 and 3:2 aspect ratio are played at a 16:9 aspect ratio. In this case the top and bottom of the image will be slightly cropped.

Note

- Wide Zoom is not available for movies or 16:9 images.

Histogram

A histogram is a graph showing the brightness of an image. The graph display indicates a bright image when skewed to the right side, and a dark image when skewed to the left side.

Notes

- The histogram also appears when playing back a single image, but you cannot adjust the exposure.
- The histogram does not appear while recording movies, playing back movies, viewing vertical orientation images, rotating still images, using Temporarily Rotated Display, or using Wide Zoom (4:3, 3:2).
- A large difference in the histogram displayed during shooting and playback may occur when:
  - The flash strobes.
  - The shutter speed is slow or fast.
- The histogram may not appear for images recorded using other cameras.

Brightness

This sets the brightness of the LCD screen. When viewing images in bright outside light if [Brightness] is set to [Normal], reset to [Bright]. However, the battery power may decrease faster under such condition.

Number of Images

You can set the number of images displayed in index screen to 12 or 20 images.
Using the internal memory

The camera has approximately 11 MB of internal memory. This memory is not removable. Even when there is no “Memory Stick Duo” media inserted in the camera, you can record images using this internal memory.

When a “Memory Stick Duo” media is inserted
[Recording]: Images are recorded on the “Memory Stick Duo” media.
[Playback]: Images on the “Memory Stick Duo” media are played back.
[Menu, Settings, etc.]: Various functions can be performed on images on the “Memory Stick Duo” media.

When there is no “Memory Stick Duo” media inserted
[Recording]: Images are recorded using the internal memory.
[Playback]: Images stored in the internal memory are played back.
[Menu, Settings, etc.]: Various functions can be performed on images in the internal memory.

On image data stored in the internal memory

We recommend that you copy (back up) data without error using one of the following methods.

To copy (back up) data on a hard disk of your computer
Perform the procedure on pages 134 to 135 without a “Memory Stick Duo” media inserted in the camera.

To copy (back up) data on a “Memory Stick Duo” media
Prepare a “Memory Stick Duo” media with sufficient free capacity, then perform the procedure explained in [Copy] (page 57).

Notes
- You cannot import image data on a “Memory Stick Duo” media to the internal memory.
- By making a USB connection between the camera and a computer with a cable, you can import data stored in the internal memory to a computer. However you cannot export data on a computer to the internal memory.
Intelligent Auto Adjustment

Allows you to shoot still images with the setting adjusted automatically.

When you use DSC-T900, set the mode switch to (Still image).

1. Lower the lens cover to switch to shooting mode.

2. (REC Mode) → (Intelligent Auto Adjustment) → X or OK

Note

- Flash mode is set to $AUTO [Flash Auto] or ¥ [Flash Off].

On Scene Recognition

Scene Recognition operates in Intelligent Auto Adjustment mode. This function lets the camera automatically recognize the shooting conditions and shoot the image.

- The camera recognizes (Twilight), (Twilight Portrait), (Twilight using a tripod), (Backlight), (Backlight Portrait), (Landscape), (Macro) or (Portrait), and displays an icon on the screen when the scene is recognized. For details, see page 90.

If you shoot a still image of a subject that is difficult to focus on

- The shortest shooting distance is approximately 8 cm (3 1/4 inches) (W), 50 cm (19 3/4 inches) (T) (from the lens). Shoot in the Close focus mode when you shoot a subject closer than the shooting distance.
- When the camera cannot focus on the subject automatically, the AE/AF lock indicator changes to flash slowly and the beep does not sound. Either recompose the shot or change the focus setting (page 32).

Focusing may be difficult in the following situations:
- It is dark and the subject is distant.
- The contrast between the subject and the background is poor.
- The subject is seen through glass.
- The subject is moving quickly.
- There is reflective light or shiny surfaces.
- The subject is backlit or there is a flashing light.
Scene Selection

Allows you to shoot with preset settings according to the scene.

When you use DSC-T900, set the mode switch to 📷 (Still image).

1. Lower the lens cover to switch to shooting mode.

2. 📷 (REC Mode) → desired mode → OK
   or
   📷 (REC Mode) → SCN (Scene Selection) → desired mode → OK

<table>
<thead>
<tr>
<th>Scene Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISO (High Sensitivity)</td>
<td>Allows you to shoot images without a flash under low light conditions, reducing blur.</td>
</tr>
<tr>
<td>🖼 (Soft Snap)</td>
<td>Allows you to shoot images with a softer atmosphere for portraits and flowers, etc.</td>
</tr>
<tr>
<td>🏞 (Landscape)</td>
<td>Allows easy shooting of distant scenes by focusing in the distance. Shoots the clear sky and trees and flowers in vivid colors.</td>
</tr>
<tr>
<td>🖼 (Twilight Portrait)</td>
<td>Allows you to shoot sharp images of people with the night view in the background without compromising the atmosphere.</td>
</tr>
<tr>
<td>🌙 (Twilight)</td>
<td>Allows you to shoot night scenes at far distance without losing the dark atmosphere of the surroundings.</td>
</tr>
<tr>
<td>🍴 (Gourmet)</td>
<td>Selects Macro mode, allowing you to shoot food arrangements in delicious and bright colors.</td>
</tr>
<tr>
<td>🏖 (Beach)</td>
<td>Allows you to shoot the blue of the water clearly when shooting seaside or lakeside scenes.</td>
</tr>
<tr>
<td>🌧 (Snow)</td>
<td>Allows you to record clear images preventing sunken colors in snowy scenes or other places where the whole screen appears white.</td>
</tr>
<tr>
<td>🎆 (Fireworks)</td>
<td>Allows you to record fireworks in all their splendor.</td>
</tr>
</tbody>
</table>
When you shoot images using (Twilight Portrait), (Twilight) or (Fireworks) mode, the shutter speed is slower and the images tend to blur. To prevent blurring, the use of a tripod is recommended.

For shooting an image appropriately according to the scene condition, a combination of functions is determined by the camera. ✓ indicates a function is available, and — that it is unavailable.

The icons indicated under “Flash” indicate modes that are available. Some functions are not available, depending on the Scene Selection mode.

<table>
<thead>
<tr>
<th>Scene Selection</th>
<th>Macro</th>
<th>Face Detection/Smile Bracket</th>
<th>Burst/Bracket</th>
<th>White Balance</th>
<th>Red Eye Reduction</th>
<th>Anti Blink</th>
<th>Steady-Shot</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISO</td>
<td>✓/——</td>
<td>✓</td>
<td>—</td>
<td>✓*1</td>
<td>—</td>
<td>—</td>
<td>✓</td>
</tr>
<tr>
<td>(Twilight Portrait)</td>
<td>✓/——</td>
<td>✓</td>
<td>✓*2</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>(Twilight)</td>
<td>—/——</td>
<td>$ $</td>
<td>—</td>
<td>✓</td>
<td>—</td>
<td>✓</td>
<td>—</td>
</tr>
<tr>
<td>(Fireworks)</td>
<td>✓/——</td>
<td>$ SL</td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>—</td>
<td>✓</td>
</tr>
<tr>
<td>(Underwater)</td>
<td>—/——</td>
<td>$</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>✓</td>
</tr>
<tr>
<td>(Hi-Speed Shutter)</td>
<td>✓/——</td>
<td>$ $</td>
<td>—</td>
<td>✓</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

*2 [When touched] for [Face Detection] cannot be selected.
*3 You can use [Underwater White Balance] instead of [White Balance].
Easy Shooting

Allows you shoot still images using the minimum necessary functions. The settings you can change are Image Size, Flash and Self-Timer. The text size increases and indicators become easier to see.

When you use DSC-T900, set the mode switch to (Still image).

1. Lower the lens cover to switch to shooting mode.
2. (REC Mode) → EASY (Easy Shooting) →

Note
• The battery charge is used up more quickly because the screen brightness increases automatically.

Changing Image Size, Flash and Self-Timer

Image Size: MENU → [Image Size] → [Large] or [Small] → OK
Flash: MENU → [Flash] → [Auto] or [Off] → OK
Self-Timer: (Self-Timer) → (Self-Timer Off) or (Self-Timer 10sec) → OK

On Scene Recognition

Scene Recognition operates in Easy Shooting mode. This function lets the camera automatically recognize the shooting conditions and shoot the image.

• The camera recognizes (Twilight), (Twilight Portrait), (Twilight using a tripod), (Backlight), (Backlight Portrait), (Landscape), (Macro) or (Portrait), and displays an icon on the screen when the scene is recognized. For details, see page 90.
Program Auto

Allows you to shoot with the exposure adjusted automatically (both the shutter speed and the aperture value). The setting buttons for Focus, Metering Mode, ISO and EV will appear on the bottom of the screen. Also you can select various settings using the menu.

When you use DSC-T900, set the mode switch to 📸 (Still image).

1. Lower the lens cover to switch to shooting mode.
2..AUTO (REC Mode) → PGM (Program Auto) → OK

![Diagram of mode selection]
Movie Mode

Allows you to record movies with audio.

**DSC-T900:**

1. Set the mode switch to (Movie).
2. Lower the lens cover to switch to shooting mode.
3. Press the shutter button fully down.
4. To stop shooting, press the shutter button fully down again.

**DSC-T90:**

1. Lower the lens cover to switch to shooting mode.
2. AUTO (REC Mode) → (Movie Mode) → OK
3. Press the shutter button fully down.
4. To stop shooting, press the shutter button fully down again.
Movie shooting mode

Allows you to shoot with preset settings according to the scene when the camera is in Movie Mode.

DSC-T900:

1. Set the mode switch to (Movie).
2. Lower the lens cover to switch to shooting mode.
3. (Movie shooting mode) → desired mode → OK

DSC-T90:

1. Lower the lens cover to switch to shooting mode.
2. (REC Mode) → (Movie Mode) → OK
3. (Movie shooting mode) → desired mode → OK

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Auto)</td>
<td>Allows you to shoot a movie with the exposure adjusted automatically.</td>
</tr>
<tr>
<td>(High Sensitivity)</td>
<td>Allows you to shoot a movie in high sensitivity even under low light conditions.</td>
</tr>
<tr>
<td>(Underwater)</td>
<td>Allows you to shoot a movie underwater in natural colors using the housing (such as Marine Pack).</td>
</tr>
</tbody>
</table>
Smile Shutter

When the camera detects a smile, the shutter is released automatically.

When you use DSC-T900, set the mode switch to (Still image).

1. Lower the lens cover to switch to shooting mode.
2. Touch (Smile icon).

3. Wait detecting a smile.
   - When the smile level exceeds the point on the indicator, the camera records images automatically.
   - If you press the shutter button during Smile Shutter, the camera shoots the image, and then returns to Smile Shutter mode.
4. To stop shooting, touch (Smile icon) again.

**Notes**

- Shooting using the Smile Shutter ends automatically when either the “Memory Stick Duo” media or internal memory becomes full.
- Smiles may not be detected correctly depending on the conditions.
- You cannot use the Digital Zoom function.
- When (Landscape), (Twilight), (Gourmet), (Fireworks) or (Underwater) is selected in Scene Selection, you cannot use the Smile Shutter function.

**Hints for better capturing of smiles**

1. Do not cover the eyes with the bangs. Do not obscure the face by hat, masks, sunglasses, etc.
2. Try to orient the face in front of the camera and be as level as possible. Keep the eyes narrowed.
3. Give a clear smile with an open mouth. The smile is easier to detect when the teeth are showing.

- The shutter operates when any person whose face is being detected smiles.
- You can select or register the priority subject for face detection with [Face Detection] (page 93).
- If the camera does not detect a smile, set the [Smile Detection Sensitivity] in the setting MENU.
Zoom

You can enlarge the image when shooting. The camera’s optical zoom function can enlarge images up to 4x.

1. Lower the lens cover to switch to shooting mode.
2. Move the zoom (W/T) lever.
   Move the zoom (W/T) lever to the T side to zoom and move to the W side to return.
   - When the zoom scale exceeds 4x, see page 73.

Note
- The camera zooms slowly while shooting a movie.
Self-Timer

1. Lower the lens cover to switch to shooting mode.
2. $\text{self-timer}$ (Self-Timer) $\to$ desired mode $\to$ OK

<table>
<thead>
<tr>
<th>$\text{self-timer}$ Off</th>
<th>Not using the self-timer</th>
</tr>
</thead>
</table>
| $\text{self-timer}$ 10sec | Setting the 10-second delay self-timer  
When you press the shutter button, the self-timer lamp flashes and a beep sounds until the shutter operates.  
To cancel, touch $\text{self-timer}$ again. |
| $\text{self-timer}$ 2sec | Setting the 2-second delay self-timer |

**Note**

- In **EASY** (Easy Shooting) mode, you can select only $\text{self-timer}$ 10sec or $\text{self-timer}$ Off (Self-Timer Off).

💡 Reducing blurring with the two-second self-timer

- Use the 2-second delay self-timer to prevent blur of an image. The shutter is released 2 seconds after you press the shutter button, which reduces camera shake when the shutter button is pressed.
Macro/Close focus

Use this setting to capture beautiful close-up images of small subjects such as insects or flowers.

1. Lower the lens cover to switch to shooting mode.
2. \(^{\downarrow}\text{AUTO (Macro)} \rightarrow \text{desired mode} \rightarrow \text{OK}\)

<table>
<thead>
<tr>
<th>(^{\downarrow}\text{AUTO (Auto)}</th>
<th>\text{The camera adjusts the focus automatically from distant subjects to close-up.}</th>
</tr>
</thead>
<tbody>
<tr>
<td>(^{\downarrow}\text{Macro On}</td>
<td>\text{The camera adjusts the focus with priority on close-up subjects. Set Macro On when shooting close subjects.}</td>
</tr>
<tr>
<td>(^{\downarrow}\text{Close focus enabled}</td>
<td>\text{Use this mode to shoot at even closer distances than Macro recording.}</td>
</tr>
<tr>
<td></td>
<td>\text{Locked to the W side: Approximately 1 to 20 cm (13/32 to 7 7/8 inches)}</td>
</tr>
</tbody>
</table>

**Notes**

- The Auto Focus speed becomes slower when you shoot images in the Macro or Close focus mode.
- You cannot select \(^{\downarrow}\text{Macro On} \) when the camera is in Intelligent Auto Adjustment mode.
- Macro mode is fixed to \(^{\downarrow}\text{AUTO (Auto)} \) when the camera is in Movie Mode or Smile Shutter.
- Note the following points when using the Close focus mode.
  - You cannot use the Scene Recognition or Face Detection functions.
  - This mode is cancelled if you turn off the power or switch the shooting mode to another one.
  - The flash mode settings you can use in this mode are \(^{\downarrow}\text{Flash On} \) or \(^{\downarrow}\text{Flash Off} \) only.
Flash

1. Lower the lens cover to switch to shooting mode.
2. $^\text{AUTO}$ (Flash) → desired mode → OK

| $^\text{AUTO}$ (Flash Auto) | Flashes when there is insufficient light or backlight. |
| $^\text{S}$ (Flash On) | Flash always operates. |
| $^\text{SL}$ (Slow Synchro (Flash On)) | Flash always operates. The shutter speed is slow in a dark place to clearly shoot the background that is out of flash light. |
| $^\text{E}$ (Flash Off) | Flash does not operate. |

Notes

- The flash strobes twice. The first flash adjusts the light quantity.
- While charging the flash, $^\text{#}$ is displayed.
- You cannot use the flash during burst or bracket shooting.
- $^\text{S}$ (Flash On) or $^\text{SL}$ (Slow Synchro (Flash On)) are not available when the camera is in Intelligent Auto Adjustment mode.

💡When the “White circular spots” appears in flash photos

This is caused by particles (dust, pollen, etc.) floating close to the lens. When they are accentuated by the camera’s flash, they appear as white circular spots.

How can the “White circular spots” be reduced?

- Light the room and shoot the subject without a flash.
- Select $^\text{E}$ (High Sensitivity) mode in Scene Selection. ($^\text{E}$ (Flash Off) is automatically selected.)
- Even though you selected $^\text{E}$ (High Sensitivity) mode in Scene Selection, the shutter speed might be slower under low-light conditions, or in a dark place. In that case, use a tripod or hold your arms firmly at your side after pressing the shutter button.
Focus

You can change the focus method. Use the menu when it is difficult to get the proper focus in auto focus mode.
AF stands for “Auto Focus,” a function that adjusts the focus automatically.

The following steps are used in (Program Auto) mode. For details on focusing when shooting movies, see page 88.

When you use DSC-T900, set the mode switch to (Still image).

1. Lower the lens cover to switch to shooting mode.
2. (REC Mode) → (Program Auto) → OK
3. (Focus) → desired mode → OK

| (Multi AF) | Focuses on a subject in all ranges of the finder frame automatically. When you press the shutter button halfway down in still image shooting mode, a green frame is displayed round the area that is in focus.  
- When the Face Detection function is active, AF operates with priority on faces.  
- When Scene Selection is set to (Underwater), focus operation is adjusted to underwater shooting. When focus is achieved by half-pressing the shutter button, a large frame is displayed in green. |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>(Center AF)</td>
<td>Focuses on a subject in the center of the finder frame automatically. Using the AF lock function together, you can compose the image the way you want.</td>
</tr>
<tr>
<td>(Spot AF)</td>
<td>Focuses on an extremely small subject or a narrow area automatically. Using the AF lock function together, you can compose the image the way you want. Hold the camera steady so as not to misalign the subject and the AF range finder frame.</td>
</tr>
</tbody>
</table>
| 0.5 m/1.0 m/ 3.0 m/7.0 m/ ∞ (unlimited distance) | Automatically and quickly focuses on the area around a previously set distance (Semi manual). This mode is useful when repeatedly shooting a subject at the same distance or when it is difficult to get a sharp focus with automatic focusing such as when shooting a subject through a net or window.  
• Focuses on a subject in all ranges of the finder frame in Semi manual mode. |

Notes

• When you use [Digital Zoom] or [AF Illuminator], the AF range finder frame setting is disabled and AF range finder frame is displayed as a dotted line instead. In this case, the camera works to focus on the subjects at the center of the screen.
• If you set the focus mode to other than [Multi AF], [Face Detection] is fixed to [When touched].
• The focus mode is fixed to [Multi AF] while the Smile Shutter function is activated.
• The semi manual distance setting contains some errors.

💡 Quickly choosing the priority subject

Touching the screen displays a frame, and then pressing the shutter button halfway down brings the frame into focus.
Metering Mode

Selects the metering mode that sets which part of the subject to measure to determine the exposure.

The following steps are used in (Program Auto) mode. For details on using metering modes when shooting movies, see page 89.

When you use DSC-T900, set the mode switch to (Still image).

1. Lower the lens cover to switch to shooting mode.
2. (REC Mode) → (Program Auto) → OK
3. (Metering Mode) → desired mode → OK

<table>
<thead>
<tr>
<th></th>
<th>(Multi)</th>
<th>Divides into multiple regions and measures each region. The camera determines a well-balanced exposure (Multi-pattern metering).</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>(Center)</td>
<td>Measures the center of the image, and determines the exposure based on the brightness of the subject there (Center-weighted metering).</td>
</tr>
<tr>
<td></td>
<td>(Spot)</td>
<td>Measures only a part of the subject (Spot metering). This function is useful when the subject is backlit or when there is strong contrast between the subject and the background.</td>
</tr>
</tbody>
</table>

Notes
- The metering mode is fixed to [Multi] when you touch the screen to select the point to bring into focus.
- If you set the metering mode to other than [Multi], [Face Detection] is fixed to [When touched].
- The metering mode is fixed to [Multi] while the Smile Shutter function is activated.
ISO

Sets the luminous sensitivity.

The following steps are used in (Program Auto) mode. For details on the ISO sensitivity setting when Scene Selection is set to (Underwater), see page 84.

When you use DSC-T900, set the mode switch to (Still image).

1 Lower the lens cover to switch to shooting mode.
2 AUTO (REC Mode) → PGM (Program Auto) → OK

3 ISO AUTO (ISO) → desired number → OK

<table>
<thead>
<tr>
<th>ISO AUTO (Auto)</th>
<th>Sets the ISO sensitivity automatically.</th>
</tr>
</thead>
</table>

Note

- You can select only from [ISO AUTO], [ISO 80] to [ISO 800] when the shooting mode is set to Burst or Exposure Bracket mode, or when [DRO] is set to [DRO plus].

💡 Adjusting ISO Sensitivity (Recommended Exposure Index)

ISO sensitivity is a speed rating for recording media that incorporates an image sensor that receives light. Even when the exposure is the same, images differ depending on the ISO sensitivity.

High ISO sensitivity
Records a bright image even in dark locations while increasing shutter speed to reduce blur.
However, the image tends to become noisy.

Low ISO sensitivity
Records a smoother image.
However, when the exposure is insufficient, the image may become darker.
EV

You can adjust the exposure manually in 1/3 EV steps in a range of –2.0 EV to +2.0 EV.

The following steps are used in  (Program Auto) mode. For details on other shooting modes, see page 83.

When you use DSC-T900, set the mode switch to  (Still image).

1. Lower the lens cover to switch to shooting mode.
2. AUTO (REC Mode) → PGM (Program Auto) → OK

3. 0EV (EV) → desired number → OK

Note

• If you shoot a subject in extremely bright or dark conditions, or when you use the flash, the exposure adjustment may not be effective.
Adjusting the exposure for better looking images

You can create various images by adjusting the exposure and the ISO sensitivity. Exposure is the amount of light that the camera will receive when you release the shutter.

Exposure:  
Shutter speed = Length of time the camera receives light  
Aperture = Size of the opening allowing light to pass through

ISO sensitivity (Recommended Exposure Index)  
= Recording sensitivity

Overexposure = too much light  
Whitish image

Lower EV setting –  
Correct exposure

Higher EV setting +  
Underexposure = too little light  
Darker image
Viewing still images

1. Press the (Playback) button to switch to playback mode.
2. Select an image with ▶/◀.

**Note**
- You may not be able to play back some images shot using other cameras. Play back such images in Folder View (HOME ➔ (View Images) ➔ [Folder View]).

**Using [Image Only] of the DISP (screen display) setting**
- Select an image by touching the left and right sides of the screen. When you touch the center of the screen, [Normal] display mode is selected temporarily. Touch  on the upper right corner of the screen to return to [Image Only] display mode.
- In [Normal] or [Simple] display mode, touch  to switch to [Image Only] display. Touch the center of the screen to return to the previous display mode.
- To enlarge an image during playback, touch the center of the screen to display the buttons and icons temporarily, then touch the portion you want to enlarge according to the procedure described above.

**Viewing images taken with a different camera**

If you insert into this camera a “Memory Stick Duo” media containing images taken both with this camera and another camera, a screen for selecting the playback method appears. “Playback only registered images” and “Playback all images with folder view”

- If you select “Playback only registered images”, images are played back in the selected View Mode. Some images taken with other cameras may not be played back at this time.
- If you select “Playback all images with folder view”, the View Mode is switched to Folder View and all images are played back.
Playback Zoom

Plays back the enlarged image.

1 Press the (Playback) button to switch to playback mode.

2 Touch the area you want to enlarge.
   The image is enlarged to twice the previous size, with the area you touched at the center. You can also enlarge the image by moving the zoom (W/T) lever to the T side.

3 Adjust the zoom scale and position.
   The image is further enlarged each time you touch the screen.

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>▲/▼/◄/►</td>
<td>Adjusts the position.</td>
</tr>
<tr>
<td>◎/×</td>
<td>Changes the zoom scale.</td>
</tr>
<tr>
<td>◄</td>
<td>Turns ▲/▼/◄/► on/off.</td>
</tr>
<tr>
<td>×</td>
<td>Cancels playback zoom.</td>
</tr>
</tbody>
</table>

💡To save enlarged images

- You can save an enlarged image by using the Trimming function (MENU → [Retouch] → [Trimming]).
Image Index

Displays multiple images at the same time. To return to the single-image screen, touch the thumbnail image on the index screen.

1. Press the (Playback) button to switch to playback mode.
2. (Image Index) → touch / to turn the pages.

Changing the display format

Touch (View Mode) to change the way images are played back (View Mode) when a “Memory Stick Duo” media is inserted into the camera.

- (Date View): → page 47
- (Event View): → page 48
- (Favorites): → page 49
- (Folder View): → page 50

- If you touch DISP in index mode, you can set the number of images displayed in the index screen to 12 or 20 images.
**Slideshow**

Images are automatically played back in succession along with effects and music.

1. Press the (Playback) button to switch to playback mode.
2. (Slideshow) → desired mode → OK → [Start]
3. Touch the screen and then touch [Exit] to end the slideshow.

**Notes**
- You cannot play back movies.
- Settings other than [Image] is stored until the next time they are changed.

**Image**

Selects the group of images to be shown.

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ All</td>
<td>Plays a slideshow of all the still images in order.</td>
</tr>
<tr>
<td>This Date</td>
<td>Plays a slideshow of still images with the currently selected date range when the view mode is (Date View).</td>
</tr>
<tr>
<td>This Event</td>
<td>Plays a slideshow of still images in the currently selected event group when the view mode is (Event View).</td>
</tr>
<tr>
<td>Favorites 1 – 6</td>
<td>Plays a slideshow of still images in the currently selected Favorites number when the view mode is (Favorites).</td>
</tr>
<tr>
<td>Folder</td>
<td>Plays a slideshow of still images in the currently selected folder when the view mode is (Folder View).</td>
</tr>
</tbody>
</table>

**Note**
- This setting is fixed to [Folder] when the internal memory is used to record images.

**Effects**

Selects the playback speed and mood for slideshows.

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ Simple</td>
<td>A simple slideshow switching still images at a preset interval. The playback interval is adjustable in [Interval] and you can thoroughly enjoy your images.</td>
</tr>
<tr>
<td>Nostalgic</td>
<td>A moody slideshow reproducing the atmosphere of a movie scene.</td>
</tr>
<tr>
<td>Stylish</td>
<td>A stylish slideshow proceeding at a middle tempo.</td>
</tr>
<tr>
<td>Active</td>
<td>A high-tempo slideshow suitable for active scenes.</td>
</tr>
</tbody>
</table>
Music

Specifies the music to be played during slideshows. You can select more than one background music track. Touch the panel to adjust the volume of the music with ø/é.

<table>
<thead>
<tr>
<th>Mute</th>
<th>Does not use BGM.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ Music1</td>
<td>The default setting for a [Simple] slideshow.</td>
</tr>
<tr>
<td>Music2</td>
<td>The default setting for a [Nostalgic] slideshow.</td>
</tr>
<tr>
<td>Music3</td>
<td>The default setting for a [Stylish] slideshow.</td>
</tr>
<tr>
<td>Music4</td>
<td>The default setting for a [Active] slideshow.</td>
</tr>
</tbody>
</table>

Interval

Sets the screen switching interval. The setting is fixed to [Auto] when [Simple] is not selected as the [Effects].

<table>
<thead>
<tr>
<th>Interval</th>
<th>Sets the display interval of images for a [Simple] slideshow.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 sec</td>
<td></td>
</tr>
<tr>
<td>✔ 3 sec</td>
<td>Sets the display interval of images for a [Simple] slideshow.</td>
</tr>
<tr>
<td>5 sec</td>
<td></td>
</tr>
<tr>
<td>10 sec</td>
<td>The interval is set to suit the selected [Effects] item.</td>
</tr>
<tr>
<td>Auto</td>
<td></td>
</tr>
</tbody>
</table>

Repeat

Turns slideshow repeat on or off.

<table>
<thead>
<tr>
<th>Repeat</th>
<th>Plays back images in a continuous loop.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ On</td>
<td>Plays back images in a continuous loop.</td>
</tr>
<tr>
<td>Off</td>
<td>After all the images have been played back, the slideshow ends.</td>
</tr>
</tbody>
</table>

💡 Selecting background music

You can transfer a desired music file from your CDs or MP3 files to the camera to play back during slideshow. To transfer music, install the “Music Transfer” software (supplied) to your computer. For details, see pages 138 and 141.

- You can record up to four pieces of music on the camera (The 4 preset pieces (Music1 – Music4) can be replaced with the ones you transferred).
- A maximum length of each music file for music playback of the camera is about 5 minutes.
- If you cannot play back a music file due to damage or other malfunctions to the file, execute [Format Music] (page 52) and transfer the music again.
Delete

Allows you to select unwanted images for deletion. You can also delete images from the MENU (page 114).

**Notes**
- When the internal memory is used to record images, the View Mode is set to [Folder View].
- You cannot delete images when the View Mode is set to [Favorites].

**Deleting images in single-image mode**

1. Press the (Playback) button to switch to playback mode.
2. Display the image you want to delete → (Delete) → [OK]

**Deleting images in index mode**

1. Press the (Playback) button to switch to playback mode.
2. Touch (Image Index) to display in index mode.
3. (Delete) → touch the image you want to delete → (Delete) → [OK]
   - Touch an image with ✓ mark to release the ✓ mark.

💡 You can switch between index and single-image mode when selecting images.

Touch on the index screen to return to the single-image screen, and touch on the single-image screen to return to index screen.
- You can also switch between index and single-image mode in [Add / Remove Favorites], [Protect] or [DPOF].
Wide Zoom

In single-image mode, still images at a 4:3 and 3:2 aspect ratio are played at a 16:9 aspect ratio. In this case the top and bottom of the image will be slightly cropped.

1. Press the  (Playback) button to switch to playback mode.
2. Touch  (Wide Zoom).
3. To cancel Wide Zoom, touch  (Wide Zoom) again.

**Note**
- Wide Zoom is not available for movies and 16:9 images.
Temporarily Rotated Display

This is used in the single-image mode to temporarily rotate an image and enlarge it on the screen.

1. Press the (Playback) button to switch to playback mode.
2. Select the vertical orientation image → touch (Temporarily Rotated Display).
3. To cancel the display, touch (Temporarily Rotated Display) again.

Notes

• Temporarily rotated display is not available for movies or horizontal orientation images.
• Touching / cancels temporarily rotated display.
**Viewing movies**

1. Press the (Playback) button to switch to playback mode.
2. Select a movie with ✔/✔.
3. Touch ● (Playback).

<table>
<thead>
<tr>
<th>Button</th>
<th>Playback feature</th>
</tr>
</thead>
<tbody>
<tr>
<td>❂vol</td>
<td>Volume control</td>
</tr>
<tr>
<td>❂</td>
<td>Normal playback</td>
</tr>
<tr>
<td>❂</td>
<td>Stop</td>
</tr>
<tr>
<td>❂/❖/❖/❖/❖</td>
<td>Fast forward/fast rewind</td>
</tr>
</tbody>
</table>

**Note**
- You may not be able to play back some images shot using other cameras.

💡 **Using [Image Only] mode of DISP (screen display) setting**

- Select an image by touching the left and right sides of the screen. When you touch the center of the screen, [Normal] display mode is selected temporarily. Touch OFF on the upper right corner of the screen to return to [Image Only] display mode.
- In [Normal] or [Simple] display mode, touch OFF to switch to [Image Only] display. Touch the center of the screen to return to the previous display mode.
Date View

Separates the images by the date. This is useful for checking when you took particular photos because the images are divided up by date.

1. HOME → (View Images) → [Date View] → OK

2. Select the date you want to display with ▲/▼.

Notes
- This item is not displayed when the internal memory is used to record images.
- When images recorded with other cameras cannot be played back on this camera, view the images in [Folder View].

To select the playback image by the calendar

Touch (Date List) in index mode and you can select from the date view the date on which the images you want to play back were taken.
Event View

Automatically separates images by date and frequency, and displays the images in groups.

1. **HOME** → (View Images) → [Event View] →

2. Select the event group you want to display with ↑/↓.

**Notes**
- This item is not displayed when the internal memory is used to record images.
- When images recorded with other cameras cannot be played back on this camera, view the images in [Folder View].

To select the playback image by the event list

Touch (List) in index mode and you can select the event group containing the image you want to play back from the Event List.

You can enter a desired event name for each group using the “PMB” software (supplied).

For details on entering the event name, see the “PMB Guide”.

Event List Event name
Favorites

Displays images for each Favorites group in which you have registered images (page 108).

1. HOME → (View Images) → [Favorites] →

2. Touch the Favorites number you want to display.

Notes

- This item is not displayed when the internal memory is used to record images.
- When images recorded with other cameras cannot be played back on this camera, view the images in [Folder View].
Folder View

Displays images for each folder created using [Create REC.Folder] of the [Memory Tool].

1. **HOME** → (View Images) → [Folder View] →

2. Select the folder you want to display with ▲/▼.

💡 To select the playback folder

Touch (Select Folder) in index mode and you can select the playback folder containing the image you want to play back from the folder.

- When there is only one folder, create a recording folder.
- This item is not displayed when the internal memory is used to record images.
Download Music

You can use “Music Transfer” in the CD-ROM (supplied) to change background music tracks.

1. HOME → Music (Slideshow) → [Music Tool] → OK → [Download Music] → OK
   The message “Connect to PC” is displayed.

2. Make a USB connection between the camera and a computer, then start “Music Transfer”.

3. Follow the instructions on the screen to change music files.
Format Music

You can delete all the background music files stored in the camera. It can be used in cases such as when the background music files are damaged and cannot be played.

1. HOME → 🎵 (Slideshow) → [Music Tool] → OK → [Format Music] → OK → [OK]

💡 Restoring the music preset at the factory to the camera

You can use “Music Transfer” in the CD-ROM (supplied) to reset music files to the preset ones.

① Make a USB connection between the camera and a computer.
② Start “Music Transfer”, then restore the default music.
   • For details on using “Music Transfer”, see the help in “Music Transfer”.

52GB
Format

Formats the “Memory Stick Duo” media or the internal memory. A commercially available “Memory Stick Duo” media is already formatted, and can be used immediately.

1. **HOME** → (Manage Memory) → [Memory Tool] → OK → [Format] → OK → [OK]

---

**Note**

- Note that formatting permanently erases all data including even protected images.
Create REC.Folder

Creates a folder in the “Memory Stick Duo” media for recording images. Images are recorded in the newly created folder until you create another folder or select another recording folder.

1. **HOME** → (Manage Memory) → [Memory Tool] → [OK] → [Create REC.Folder] → [OK]

**Notes**
- This item is not displayed when the internal memory is used to record images.
- When you insert a “Memory Stick Duo” media that was used with other equipment into the camera and shoot images, a new folder is automatically created.
- Up to 4,000 images can be stored in one folder. When the folder capacity is exceeded, a new folder is automatically created.

**On the folders**
- After a new folder is created, you can change the storage destination folder (page 55) and select the folder for viewing images (page 104).
Change REC.Folder

Changes the folder in the “Memory Stick Duo” media that is currently used for recording images.

1. HOME → [Manage Memory] → [Memory Tool] → OK → [Change REC.Folder] → OK

2. Select the folder you want to record → Touch [OK].

Notes

- This item is not displayed when the internal memory is used to record images.
- You cannot select the following folder as a recording folder.
  - “100” folder
  - A folder with a number that has either “□□□MSDCF” or “□□□MNV01” only.
- You cannot move recorded images to another folder.
Delete REC.Folder

Deletes a folder in the “Memory Stick Duo” media that is currently used for recording images.

1  HOME → (Manage Memory) → [Memory Tool] → OK → [Delete REC.Folder] → OK

2  Select the folder you want to delete → Touch [OK].

Notes
- This item is not displayed when the internal memory is used to record images.
- If you delete the folder set as the recording folder using [Delete REC.Folder], the folder that has the largest folder number is selected as the next recording folder.
- You can delete only empty folders. If a folder contains images, or even files that cannot be played back by the camera, first delete these images and files, and then delete the folder.
Copy

Copies all images in the internal memory to a “Memory Stick Duo” media.

1 Insert a “Memory Stick Duo” media with sufficient free space into the camera.

2  HOME → (Manage Memory) → [Memory Tool] → OK → [Copy] → OK → [OK]

Notes

• Use a fully charged battery pack. If you attempt to copy image files using a battery pack with little remaining charge, the battery pack may run out, causing copying to fail or possibly corrupting the data.
• You cannot copy images individually.
• The original images in the internal memory are retained even after copying. To delete the contents of the internal memory, remove the “Memory Stick Duo” media after copying, then format the internal memory ([Format] in [Internal Memory Tool]).
• A new folder is created on the “Memory Stick Duo” media and all the data will be copied to it. You cannot choose a specific folder and copy images to it.
**File Number**

Selects the method used to assign file numbers to images.

1. **HOME** → (Manage Memory) → [Memory Tool] → ![OK](image) → [File Number] → ![OK](image) → desired mode → ![OK](image)

<table>
<thead>
<tr>
<th>Series</th>
<th>Assigns numbers to files in sequence even if the recording folder or the “Memory Stick Duo” media is changed. (When the replaced the “Memory Stick Duo” media contains a file with a number higher than the last assigned number, a number one higher than the largest number is assigned.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset</td>
<td>Starts from 0001 each time the folder is changed. (When the recording folder contains a file, a number one higher than the largest number is assigned.)</td>
</tr>
</tbody>
</table>
Beep

Selects or turns off the sound produced when you operate the camera.

1. **HOME** → 🎞️ (Settings) → [Main Settings] → ☑️ → [Beep] → ☑️ → desired mode → ☑️

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shutter</td>
<td>Turns on the shutter sound when you press the shutter button.</td>
</tr>
<tr>
<td>High</td>
<td>Turns on the beep/shutter sound when you operate the touch panel/press the shutter button.</td>
</tr>
<tr>
<td>Low</td>
<td>If you want to lower the volume, select [Low].</td>
</tr>
<tr>
<td>Off</td>
<td>Turns off the beep/shutter sound.</td>
</tr>
</tbody>
</table>

**Note**
- When the camera is connected to a TV using the HDMI Cable (sold separately), the beep sound is fixed to [Shutter].
Function Guide

You can select whether or not function guide is displayed when you operate the camera.

1. HOME → (Settings) → [Main Settings] → OK → [Function Guide] → OK → desired mode → OK

<table>
<thead>
<tr>
<th>✔</th>
<th>On</th>
<th>Displays the function guide.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Off</td>
<td>Does not display the function guide.</td>
</tr>
</tbody>
</table>

**Note**

- The guide is displayed during playback even if this is set to [Off].
Initialize

Initializes the setting to the default setting. Even if you execute this function, the images are retained.

1. HOME →  (Settings) → [Main Settings] → OK → [Initialize] → OK → [OK]

Note

- Be sure not to turn off the camera while initializing.
Calibration

Enables you to perform calibration when the touch panel buttons do not react at the appropriate points where you touch.

1. HOME → (Settings) → [Main Settings] → OK → [Calibration] → OK

2. Using the paint pen, touch the center of the × mark displayed on the screen in order.

**Notes**

- To stop the calibration process mid-way, touch [Cancel]. The adjustments made up to that point are not effected.
- If you fail to touch the right spot, the calibration is not performed. Touch the center of the × mark again.
Housing

Changes the function of some buttons to operate the camera when installed in the Housing (Marine Pack). Refer also to the operating instructions supplied with the Housing.

1. HOME → 📺 (Settings) → [Main Settings] → OK → [Housing] → OK → desired mode →

| On (✓) | Changes the function of the buttons. |
| Off | Does not change any functions. |

Notes
- Objects cannot be brought into focus by touching the screen.
- DISP (screen display) is fixed to [Normal].
- There are limitations on some functions and some buttons are not displayed on the screen.
Demo Mode

You can set whether to use a demonstration of the Scene Recognition and Smile Shutter. When there is no need to view a demonstration, set to [Off].

When you use DSC-T900, set the mode switch to (Still image).

1. **HOME** → (Settings) → [Main Settings] → [Demo Mode] → desired mode
2. **AUTO** (REC Mode) → **AUTO** (Intelligent Auto Adjustment) → **OK**

<table>
<thead>
<tr>
<th>On</th>
<th>Demonstrates the Scene Recognition and Smile Shutter mode.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ Off</td>
<td>Does not perform a demonstration.</td>
</tr>
</tbody>
</table>

View a demonstration of Scene Recognition

1. Point the camera at the subject.
   - When Scene Recognition is performed, the icon and a description of the recognized scene appear on the screen.
2. Press the shutter button.
   - The image is recorded as a normal shooting.

View a demonstration of Smile Shutter

1. Touch 😊 (Smile icon).
2. Point the camera at the subject.
   - The camera automatically operates the shutter when a smiling face is detected, but no image is recorded.
3. Touch 😊 (Smile icon) again to exit the demo mode.

Notes
- Macro mode is fixed to [Auto].
- Auto review is fixed to [On].
- [REC Mode] is fixed to [Normal].
- When (screen display) is set to [Normal], some of the icons are not displayed on the LCD screen.
- When demonstrating the Scene Recognition mode, the setting is fixed to [Auto].
- Although you can release the shutter in Smile Shutter demo mode, no image is recorded.
HDMI Resolution (DSC-T900 only)

Sets the resolution to be output to a TV from the HDMI terminal when you view images by connecting the multi-output stand (supplied) of this camera to the HDMI terminal of a High Definition TV using the HDMI Cable (sold separately).

1. **HOME** → (Settings) → [Main Settings] → **OK** → [HDMI Resolution] → **OK** → desired mode → **OK**

<table>
<thead>
<tr>
<th>✓</th>
<th>Auto</th>
<th>The camera automatically recognizes an HD TV and sets the output resolution.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1080i</td>
<td>Outputs signals in HD picture quality (1080i).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• When the video signal output is NTSC, signals are output using 480p,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>whereas when the video signal output is PAL, signals are output using</td>
</tr>
<tr>
<td></td>
<td></td>
<td>576p.</td>
</tr>
</tbody>
</table>

Notes

- If you cannot display the screen properly with the [Auto] setting, select either [1080i] or [480p/576p] depending on the TV to be connected.
- Set the [Video Out] according to the TV color system of the connected equipment (page 68).
CTRL FOR HDMI (DSC-T900 only)

This setting allows (TV) remote control of a camera that is connected to a “BRAVIA” Sync TV using the HDMI Cable (sold separately). For details on “BRAVIA” Sync, see page 124.

1. HOME → (Settings) → [Main Settings] → OK → [CTRL FOR HDMI] → OK → desired mode → OK

<table>
<thead>
<tr>
<th></th>
<th>On</th>
<th>Enables remote-controlled operation.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Off</td>
<td>Disables remote-controlled operation.</td>
</tr>
</tbody>
</table>

**Note**

- You can perform the operation of the camera with the remote controller of your TV by connecting your camera to a “BRAVIA” Sync compatible TV.
COMPONENT

Selects the video signal output type from either SD or HD (1080i) in accordance with the type of TV you connect to the camera using an HD Output Adaptor Cable (sold separately).

When you use DSC-T900, use a Type2c-compliant HD Output Adaptor Cable (sold separately), whereas when you use DSC-T90, use a Type1a-compliant HD Output Adaptor Cable (sold separately).

1. HOME → (Settings) → [Main Settings] → OK → [COMPONENT] → OK → desired mode → OK

<table>
<thead>
<tr>
<th>✓ HD(1080i)</th>
<th>Select this item to connect the camera to a 1080i-capable High Definition TV.</th>
</tr>
</thead>
<tbody>
<tr>
<td>SD</td>
<td>Select this item to connect the camera to a TV that is not compatible with an HD(1080i) signal.</td>
</tr>
</tbody>
</table>

Note

- When you shoot movies in the condition where the camera and a TV are connected using an HD Output Adaptor Cable (sold separately), the image being shot is not displayed at the TV side.
Video Out

Sets the video signal output according to the TV color system of the connected video equipment. The TV color systems differ depending on the country and region. To view images on a TV screen, check the TV color system of the country or region of use (pages 126, 129).

1. **HOME** → 📺 (Settings) → [Main Settings] → OK → [Video Out] → OK → desired mode

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTSC</td>
<td>Sets the video output signal to NTSC mode (e.g., for the USA, Japan).</td>
</tr>
<tr>
<td>PAL</td>
<td>Sets the video output signal to PAL mode (e.g., for Europe, China).</td>
</tr>
</tbody>
</table>
TV TYPE

Set to the aspect ratio of television to be connected for playback.

1. HOME → 📺 (Settings) → [Main Settings] → OK → [TV TYPE] → OK → desired mode →

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️ 16:9</td>
<td>Selects this item to play back the images on a wide screen television.</td>
</tr>
<tr>
<td>4:3</td>
<td>Selects this item to play back the images on a 4:3 ratio television.</td>
</tr>
</tbody>
</table>
USB Connect

Sets the mode when the camera is connected to a computer or a PictBridge compliant printer using the USB Cable (DSC-T900) or cable for multi-use terminal (DSC-T90).

1. HOME → (Settings) → [Main Settings] → OK → [USB Connect] → OK → desired mode

<table>
<thead>
<tr>
<th>✔️</th>
<th>Auto</th>
<th>The camera recognizes automatically and sets up communication with a computer or PictBridge compliant printer.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>PictBridge</td>
<td>Connects the camera to a PictBridge compliant printer.</td>
</tr>
<tr>
<td></td>
<td>PTP/MTP</td>
<td>When you connect the camera to a computer, the AutoPlay Wizard appears, and the still images in the recording folder on the camera are imported to the computer. (with Windows Vista/XP, Mac OS X)</td>
</tr>
<tr>
<td></td>
<td>Mass Storage</td>
<td>Establishes a Mass Storage connection between the camera and a computer or other USB device.</td>
</tr>
</tbody>
</table>

Notes

- If you cannot connect the camera to a PictBridge compliant printer with the [Auto] setting, select [PictBridge].
- If you cannot connect the camera to a computer or a USB device with the [Auto] setting, select [Mass Storage].
- You cannot import movies when [PTP/MTP] is selected. To import movies to the computer, select [Auto] or [Mass Storage].
AF Illuminator

The AF illuminator supplies fill light to focus more easily on a subject in dark surroundings. The AF illuminator emits red light allowing the camera to focus easily when the shutter button is pressed halfway, until the focus is locked. The \( \text{ON} \) indicator appears at this time.

1. HOME \( \rightarrow \)  (Settings) \( \rightarrow \) [Shooting Settings] \( \rightarrow \) [AF Illuminator] \( \rightarrow \) OK \( \rightarrow \) desired mode

<table>
<thead>
<tr>
<th>✅</th>
<th>Auto</th>
<th>Uses the AF illuminator.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✗</td>
<td>Off</td>
<td>Does not use AF illuminator.</td>
</tr>
</tbody>
</table>

Notes

- Focus is achieved as long as the AF illuminator light reaches the subject, regardless of whether light fails to reach the center of the subject.
- You cannot use the AF illuminator when:
  - [Focus] is set to Semi manual mode.
  - \( \text{ } \) (Landscape) mode, \( \text{ } \) (Twilight) mode, \( \text{ } \) (Fireworks) mode or \( \text{ } \) (Hi-Speed Shutter) mode is selected in the Scene Selection mode.
  - [Housing] is set to [On].
- When you use AF illuminator, the normal AF range finder frame is disabled and a new AF range finder frame is displayed by a dotted line. AF operates with priority on subjects located near the center of the frame.
- The AF illuminator emits very bright light. Although there is no health hazard, do not look directly into the AF illuminator emitter at close range.
Grid Line

With reference to the grid lines, you can easily set a subject in a horizontal/vertical position.

1. HOME → (Settings) → [Shooting Settings] → OK → [Grid Line] → OK → desired mode →

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Displays the grid lines. The grid lines are not recorded.</td>
</tr>
<tr>
<td>Off</td>
<td>Does not display the grid lines.</td>
</tr>
</tbody>
</table>

72 GB

Grid Line

With reference to the grid lines, you can easily set a subject in a horizontal/vertical position.

1. HOME → (Settings) → [Shooting Settings] → OK → [Grid Line] → OK → desired mode →

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Displays the grid lines. The grid lines are not recorded.</td>
</tr>
<tr>
<td>Off</td>
<td>Does not display the grid lines.</td>
</tr>
</tbody>
</table>
Digital Zoom

Selects the digital zoom mode. The camera enlarges the image using optical zoom (up to 4×). When the zoom scale is exceeded, the camera uses either smart or precision digital zoom.

1. HOME → (Settings) → [Shooting Settings] → OK → [Digital Zoom] → OK → desired mode

<table>
<thead>
<tr>
<th>Smart (Smart)</th>
<th>Enlarges the image digitally within the range where the image will not be distorted, according to the image size. (Smart zoom)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Precision (Precision)</td>
<td>Enlarges all image sizes by the total zoom scale of approximately 8×, including the optical zoom 4×. However, note that the picture quality deteriorates when the optical zoom scale is exceeded. (Precision digital zoom)</td>
</tr>
<tr>
<td>Off</td>
<td>Does not use the digital zoom.</td>
</tr>
</tbody>
</table>

**Notes**

- The Digital Zoom function does not operate when shooting movies or while the Smile Shutter function is activated.
- The smart zoom is not available when the image size is set to [12M], [3:2(11M)] or [16:9(9M)].
- The Face Detection function does not work when using the Digital Zoom.

**Total zoom scale when using Smart zoom (including optical zoom 4×)**

The supported zoom ratio differs depending on the image size.

<table>
<thead>
<tr>
<th>Size</th>
<th>Total zoom scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>8M</td>
<td>Approx. 4.9×</td>
</tr>
<tr>
<td>5M</td>
<td>Approx. 6.2×</td>
</tr>
<tr>
<td>3M</td>
<td>Approx. 7.8×</td>
</tr>
<tr>
<td>VGA</td>
<td>Approx. 25×</td>
</tr>
<tr>
<td>16:9(2M)</td>
<td>Approx. 8.3×</td>
</tr>
</tbody>
</table>
Auto Orientation

When the camera is rotated to shoot a portrait (vertical) image, the camera records its position change and displays the image in the portrait position.

1. **HOME** → ☰ (Settings) → [Shooting Settings] → ☰ → [Auto Orientation] → ☰ → desired mode → ☰

| ✓ On | Records the image with the correct orientation. |
| Off | Does not use Auto Orientation. |

**Notes**

- Black is displayed to the left and right of vertical orientation images.
- Depending on the shooting angle of the camera, the orientation of the image may not be recorded correctly.
- You cannot use [Auto Orientation] when ☰ (Underwater) is selected in the Scene Selection or when shooting movies.
- Sometimes the Auto Orientation function does not operate when you use the AC Adaptor (sold separately) and the USB/AV/DC IN Cable for multi-use terminal (sold separately). When you use DSC-T900, use a Type2c-compliant USB/AV/DC IN Cable for multi-use terminal (sold separately), whereas when you use DSC-T90, use a Type1a-compliant USB/AV/DC IN Cable for multi-use terminal (sold separately).

**Rotating images after recording**

- If the orientation of an image is incorrect, you can use the [Rotate] on the MENU screen to display the image in portrait position.
Auto Review

Displays the recorded image on the screen for approximately two seconds immediately after shooting a still image.

1. HOME → (Settings) → [Shooting Settings] → OK → [Auto Review] → OK → desired mode

<table>
<thead>
<tr>
<th></th>
<th>On</th>
<th>Uses the Auto Review.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Off</td>
<td>Does not use Auto Review.</td>
</tr>
</tbody>
</table>

Shooting another image without delay

- When you press the shutter button halfway down, the display of the recorded image disappears and you can shoot another image immediately, even if Auto Review is set to [On].

Continuing to view an Auto Review image

- When you keep the shutter button pressed down immediately after shooting, the Auto Review image remains displayed for as long as you continue to press down the shutter button.
Clock Settings

Sets the date and time.

1. HOME → (Settings) → [Clock Settings] → ] OK [ → [Clock Settings] → ] OK [  
2. Desired date display format → [ ] → touch each item and set its numeric value → [OK] 

Midnight is indicated as 12:00 AM, and noon as 12:00 PM.

Note

• The camera does not have a feature for superimposing dates on images. By using “PMB” in the CD-ROM (supplied), you can print or save images with the date.
Language Setting

Selects the language to be used in the menu items, warnings and messages.

1. HOME → (Settings) → [Language Setting] → OK → [Language Setting] → OK → desired mode → OK
Image Size

The image size determines the size of the image file that is recorded when you take a image. The larger the image size, the more detail will be reproduced when the image is printed on large-format paper. The smaller the image size, the more images can be recorded. Select the image size that matches the way you will view your images.

1. Lower the lens cover to switch to shooting mode.
2. MENU → (Image Size) → desired mode →

When shooting still images

<table>
<thead>
<tr>
<th>Image size</th>
<th>Usage guidelines</th>
<th>LCD screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>(4000×3000)</td>
<td>For prints up to A3+ size</td>
<td></td>
</tr>
<tr>
<td>(3264×2448)</td>
<td>For prints up to A3 size</td>
<td></td>
</tr>
<tr>
<td>(2592×1944)</td>
<td>For prints up to A4 size</td>
<td></td>
</tr>
<tr>
<td>(2048×1536)</td>
<td>For prints up to L/2L size</td>
<td></td>
</tr>
<tr>
<td>(640×480)</td>
<td>For e-mail attachments</td>
<td></td>
</tr>
<tr>
<td>(4000×2672)</td>
<td>3:2 aspect ratio as in photo prints and postcards</td>
<td>Images are displayed in 4:3 or 3:2 aspect ratio.</td>
</tr>
<tr>
<td>(4000×2248)</td>
<td>For viewing on a high-definition TV.</td>
<td></td>
</tr>
<tr>
<td>(1920×1080)</td>
<td>Images will fill the entire screen.</td>
<td></td>
</tr>
</tbody>
</table>

Note
- When you print images recorded with 16:9 aspect ratio, both edges may be cut off.

In Easy Shooting mode

<table>
<thead>
<tr>
<th></th>
<th>Shoots images in [12M] size.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Large</td>
<td>Small</td>
</tr>
<tr>
<td>Shoots images in [3M] size.</td>
<td></td>
</tr>
</tbody>
</table>
When shooting movies

The larger the size of the movie image, the higher the image quality. The higher the amount of data used per second (average bit rate), the smoother the playback image.

The movies shot with this camera will be recorded in MPEG-4, Approx. 30fps, Progressive, AAC, mp4 format.

<table>
<thead>
<tr>
<th>Movie image size</th>
<th>Average bit rate</th>
<th>Usage guidelines</th>
</tr>
</thead>
<tbody>
<tr>
<td>1280×720 (Fine)</td>
<td>9 Mbps</td>
<td>Shoot highest quality movies for display on High Definition TV.</td>
</tr>
<tr>
<td>1280×720 (Standard)</td>
<td>6 Mbps</td>
<td>Shoot standard quality movies for display on High Definition TV.</td>
</tr>
<tr>
<td>VGA</td>
<td>3 Mbps</td>
<td>Shoot an image size suitable for WEB upload.</td>
</tr>
</tbody>
</table>

Notes
- A telephoto image is produced when the [VGA] image size is selected for movies.
- Movies with the size set to [1280×720] can only be recorded on a “Memory Stick PRO Duo” media. When using recording media other than a “Memory Stick PRO Duo” media, set the movie image size to [VGA].

💡 On “image quality” and “image size”

A digital image is made up of a collection of small dots called pixels. If it contains a large number of pixels, the image becomes large, it takes up more memory, and the image is displayed in fine detail. “Image size” is shown by the number of pixels. Although you cannot see the differences on the screen of the camera, the fine detail and data processing time differ when the image is printed or displayed on a computer screen.

Description of the pixels and the image size

💡 Many pixels
(Fine image quality and large file size)

💡 Few pixels
(Rough image quality but small file size)
Flash

In EASY (Easy Shooting), you can select the Flash setting from MENU.

When you use DSC-T900, set the mode switch to (Still image).

1 Lower the lens cover to switch to shooting mode.
2 (REC Mode) → EASY (Easy Shooting) → AUTO

3 MENU → [Flash] → desired mode → OK

| 🔄 Auto | Flash strobes when there is insufficient light or backlight. |
| 🔄 Off  | Does not use the flash. |
**REC Mode**

You can select Normal (single-image), Burst or Exposure Bracket as the shooting mode.

When you use DSC-T900, set the mode switch to  (Still image).

1. Lower the lens cover to switch to shooting mode.
2. **MENU** →  (REC Mode) → desired mode →

<table>
<thead>
<tr>
<th></th>
<th>(Normal)</th>
<th>Records a single image.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>(Burst)</td>
<td>Records up to 100 images in succession when you press and hold down the shutter button.</td>
</tr>
</tbody>
</table>

**Notes**
- The Burst mode is not available in **EASY** (Easy Shooting), Movie Mode or Smile Shutter.
- The flash is set to  (Flash Off).
- When recording with the self timer, a series of a maximum of five images is recorded.
- The recording interval becomes longer, depending on the setting for the image size.
- When the battery level is low, or when the internal memory or a “Memory Stick Duo” media is full, the Burst stops.
- The focus, white balance, and exposure are adjusted for the first image, and these settings are also used for the other images.
<table>
<thead>
<tr>
<th>BRK±0.3EV</th>
<th>BRK±0.7EV</th>
<th>BRK±1.0EV</th>
</tr>
</thead>
<tbody>
<tr>
<td>Records a series of three images with the exposure values automatically shifted (Exposure Bracket). When you cannot decide the correct exposure, shoot in the Exposure Bracket mode, shifting the exposure value. You can select the image with the best exposure afterward. The larger the bracket step value, the larger the shift of the exposure value.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Notes
- The Exposure Bracket mode is not available in AUTO (Intelligent Auto Adjustment), EASY (Easy Shooting), Movie Mode or Smile Shutter.
- The flash is set to [Flash Off].
- The focus and white balance are adjusted for the first image, and these settings are also used for the other images.
- When you adjust the exposure manually, the exposure is shifted based on the adjusted brightness.
- The recording interval may become longer depending on the shooting conditions.
- If the subject is too bright or too dark, you may not be able to shoot properly with the selected bracket step value.
EV

You can adjust the exposure manually in 1/3 EV steps in a range of –2.0 EV to +2.0 EV.

For details on EV setting in PGM (Program Auto) mode, see page 36.

1. Lower the lens cover to switch to shooting mode.
2. MENU → 0EV (EV) → desired number → OK

Notes
- [EV] is not available in EASY (Easy Shooting) mode.
- If you shoot a subject in extremely bright or dark conditions, or when you use the flash, the exposure adjustment may not be effective.

Adjusting the exposure for better looking images

You can create various images by adjusting the exposure and the ISO sensitivity. Exposure is the amount of light that the camera will receive when you release the shutter.

Overexposure = too much light
Whitish image

Lower EV setting –
Correct exposure

Higher EV setting +

Underexposure = too little light
Darker image
ISO

Sets the luminous sensitivity.

For details on ISO sensitivity setting in \( \text{Rec} \) (Program Auto), see page 35.

When you use DSC-T900, set the mode switch to \( \text{Still image} \).

1 Lower the lens cover to switch to shooting mode.

2 \( \text{REC Mode} \) \( \rightarrow \) \( \text{Scene Selection} \) \( \rightarrow \) \( \text{Underwater} \) \( \rightarrow \) \( \text{OK} \)

3 \( \text{MENU} \) \( \rightarrow \) \( \text{ISO} \) \( \rightarrow \) desired number \( \rightarrow \) \( \text{OK} \)

<table>
<thead>
<tr>
<th>✔</th>
<th>ISO (Auto)</th>
<th>Sets the ISO sensitivity automatically.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>[ISO AUTO], [ISO 80] to [ISO 800]</td>
<td>You can reduce image blurring in dark locations or moving subjects by increasing ISO sensitivity (select a larger number).</td>
</tr>
</tbody>
</table>

**Note**

- You can select only from [ISO AUTO], [ISO 80] to [ISO 800] when the shooting mode is set to Burst or Exposure Bracket mode, or when [DRO] is set to [DRO plus].

**Adjusting ISO Sensitivity (Recommended Exposure Index)**

ISO sensitivity is a speed rating for recording media that incorporates an image sensor that receives light. Even when the exposure is the same, images differ depending on the ISO sensitivity.

**High ISO sensitivity**
Records a bright image even in dark locations while increasing shutter speed to reduce blur.
However, the image tends to become noisy.

**Low ISO sensitivity**
Records a smoother image.
However, when the exposure is insufficient, the image may become darker.
White Balance

Adjusts color tones according to the surrounding light conditions. Use this function if image color appears unnatural.

1. Lower the lens cover to switch to shooting mode.

2. \( \text{MENU} \rightarrow \text{WB AUTO (White Balance)} \rightarrow \text{desired mode} \)

<table>
<thead>
<tr>
<th>WB AUTO (Auto)</th>
<th>Adjusts the white balance automatically so that the colors appear natural.</th>
</tr>
</thead>
<tbody>
<tr>
<td>☀ (Daylight)</td>
<td>Adjusts for outdoors conditions on a fine day, evening views, night scenes, neon signs, fireworks, etc.</td>
</tr>
<tr>
<td>🌧 (Cloudy)</td>
<td>Adjusts for a cloudy sky or a shady location.</td>
</tr>
<tr>
<td>🎧 (Fluorescent Light 1)</td>
<td>[Fluorescent Light 1]: Adjusts for white fluorescent lighting.</td>
</tr>
<tr>
<td>🎧 (Fluorescent Light 2)</td>
<td>[Fluorescent Light 2]: Adjusts for natural white fluorescent lighting.</td>
</tr>
<tr>
<td>🎧 (Fluorescent Light 3)</td>
<td>[Fluorescent Light 3]: Adjusts for day white fluorescent lighting.</td>
</tr>
<tr>
<td>🌇 (Incandescent)</td>
<td>Adjusts for places under incandescent lamp, or under bright lighting, such as in a photo studio.</td>
</tr>
<tr>
<td>✡WB (Flash)</td>
<td>Adjusts for the flash conditions.</td>
</tr>
</tbody>
</table>

Notes
- You cannot select [White Balance] in \( \text{Smile} \) (Intelligent Auto Adjustment), \( \text{EASY} \) (Easy Shooting) mode.
- You can select [White Balance] only when \( \text{ISO} \) (High Sensitivity) or \( \text{H} \) (Gourmet) mode is selected in Scene Selection.
- When shooting movies, you cannot select [Flash] in [White Balance] when \( \text{ISO} \) (High Sensitivity) mode is selected in Scene Selection.
- Under fluorescent lights that flicker, the white balance function may not work correctly even though you select [Fluorescent Light 1], [Fluorescent Light 2] or [Fluorescent Light 3].
- When shooting with a flash in other than [Flash] mode, [White Balance] is set to [Auto].
Effects of lighting conditions

The apparent color of the subject is affected by the lighting conditions. The color tones are adjusted automatically in the Intelligent Auto Adjustment mode, but you can adjust color tones manually using the White Balance function.

<table>
<thead>
<tr>
<th>Weather/lighting</th>
<th>Daylight</th>
<th>Cloudy</th>
<th>Fluorescent</th>
<th>Incandescent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Characteristics of light</td>
<td>White (standard)</td>
<td>Bluish</td>
<td>Green-tinged</td>
<td>Reddish</td>
</tr>
</tbody>
</table>
Underwater White Balance

Adjusts the color tone when the camera is set to (Underwater) mode in Scene Selection or (Underwater) mode in Movie Mode.

1. **MENU** → [WB] (Underwater White Balance) → desired mode → [OK]

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Auto)</td>
<td>Automatically adjusts the color tones for underwater conditions to make the colors appear natural.</td>
</tr>
<tr>
<td>(Underwater 1)</td>
<td>Adjusts for underwater conditions where blue is strong.</td>
</tr>
<tr>
<td>(Underwater 2)</td>
<td>Adjusts for underwater conditions where green is strong.</td>
</tr>
</tbody>
</table>

**Notes**

- Depending on the color of the water, the Underwater White Balance may not work correctly even though you select [Underwater 1] or [Underwater 2].
- You cannot select [Underwater White Balance] when the flash mode is set to [Flash On].
Focus (Movie)

Changes the focusing method for shooting movies. Use the menu when it is difficult to get the proper focus in auto focus mode.

For details on focus methods in PGM (Program Auto) mode, see page 32.

**DSC-T900:**
1. Set the mode switch to 🎥 (Movie).
2. Lower the lens cover to switch to shooting mode.
3. **MENU** → 🎥 (Focus) → desired mode → **OK**

**DSC-T90:**
1. Lower the lens cover to switch to shooting mode.
2. 📸 AUTO (REC Mode) → 🎥 (Movie Mode) → **OK**
3. **MENU** → 🎥 (Focus) → desired mode → **OK**

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>☑️ (Multi AF)</td>
<td>Focuses on a subject in all ranges of the finder frame automatically.</td>
</tr>
<tr>
<td>∞ (unlimited distance)</td>
<td>Sets the focus to unlimited distance.</td>
</tr>
<tr>
<td></td>
<td>• Use “Semi manual” when it is difficult to get sharp focus with automatic focusing, such as when shooting a subject through a net or window.</td>
</tr>
</tbody>
</table>

**Note**
- The Focus mode is fixed to [Multi AF] when the Movie Mode is 🎥 (Underwater).
Metering Mode (Movie)

Selects the metering mode for measuring a part of the subject when the camera automatically determines the exposure for shooting a movie.

For details on metering modes in \( \text{\textit{Program Auto}} \) (Program Auto) mode, see page 34.

**DSC-T900:**

1. Set the mode switch to \( \text{\textit{Movie}} \) (Movie).
2. Lower the lens cover to switch to shooting mode.
3. \( \text{MENU} \rightarrow \text{\texttt{ \textit{\textcircled{\}}} \text{\textsuperscript{(Metering Mode)}}} \rightarrow \text{\texttt{desired mode}} \rightarrow \text{\texttt{OK}} \)

**DSC-T90:**

1. Lower the lens cover to switch to shooting mode.
2. \( \text{\texttt{AUTO}} \) (REC Mode) \( \rightarrow \text{\texttt{\textit{Movie Mode}}} \rightarrow \text{\texttt{OK}} \)

3. \( \text{MENU} \rightarrow \text{\texttt{\textcircled{\}}} \text{\textsuperscript{(Metering Mode)}} \rightarrow \text{\texttt{desired mode}} \rightarrow \text{\texttt{OK}} \)

| **\( \text{\texttt{\textcircled{\}}} \text{\textsuperscript{(Multi)}} \)** | Divides into multiple regions and measures each region. The camera determines a well-balanced exposure (Multi-pattern metering). |
| **\( \text{\texttt{\textcircled{\}}} \text{\textsuperscript{(Center)}} \)** | Measures the center of the image, and determines the exposure based on the brightness of the subject there (Center-weighted metering). |
Scene Recognition

The camera automatically detects shooting conditions, and then takes the shot. When a face is detected, the ISO sensitivity is increased according to the face movement to reduce subject blur (Face Motion Detection).

Scene Recognition icon

The camera recognizes the following types of scenes. When the camera determines the optimal scene, it displays the corresponding icon.

- (Twilight), (Twilight Portrait), (Twilight using a tripod), (Backlight), (Backlight Portrait), (Landscape), (Macro), (Portrait)

Example of an image when (Backlight) is activated.

When you use DSC-T900, set the mode switch to (Still image).

1. Lower the lens cover to switch to shooting mode.
2. AUTO (REC Mode) → AUTO (Intelligent Auto Adjustment) → X or OK
3. MENU → SCN (Scene Recognition) → desired mode → OK

<table>
<thead>
<tr>
<th></th>
<th>(Auto)</th>
<th>When the camera recognizes the scene, it switches to the optimal settings and shoots the image.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SCN</strong> (Advanced)</td>
<td>When the camera recognizes the scene, it switches to the optimal settings. When the camera recognizes (Twilight), (Twilight Portrait), (Twilight using a tripod), (Backlight) or (Backlight Portrait), it automatically changes the settings and shoots another image.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• When you shoot two images consecutively, the + mark on the icon will turn green.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• After two images are shot consecutively, you can use the Auto Review function to display these images side by side on the screen.</td>
<td></td>
</tr>
</tbody>
</table>
|      | • When the subject blinks while the camera recognizes (Portrait), the camera automatically takes one more shot. If eyes are open in the second image, only the second image is recorded. For details on the Anti Blink function, see “What is the Anti Blink function?”.'
Notes

- The Scene Recognition function does not operate when you shoot images in the Close focus mode or Digital Zoom mode.
- When the recording mode is set to Burst, or when the Smile Shutter function is activated, Scene Recognition is fixed to [Auto].
- The available flash settings are $\text{Auto}$ (Flash Auto) and $\text{Off}$ (Flash Off).
- $\text{Twilight using a tripod}$ scenes sometimes cannot be recognized in an environment where vibrations are transferred to the camera even though it is fixed on a tripod.
- Sometimes a slow shutter results when a scene is recognized as a $\text{Twilight using a tripod}$. Keep the camera still during shooting.
- The Scene Recognition icon appears regardless of $\text{Disp}$ (screen display) settings.
- These scenes may not be recognized depending on the situation.

Images you can shoot with [Advanced]

In [Advanced] mode, the camera shoots two images consecutively with the settings differing as follows when it recognizes $\text{Twilight}$, $\text{Twilight Portrait}$, $\text{Twilight using a tripod}$, $\text{Backlight}$ or $\text{Backlight Portrait}$ scenes, which tends to blur. You can select the desired image from the two images shot.

<table>
<thead>
<tr>
<th>First Image*</th>
<th>Second Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\text{Twilight}$</td>
<td>Shoots with sensitivity increased and shake reduced</td>
</tr>
<tr>
<td>$\text{Twilight Portrait}$</td>
<td>Shoots with sensitivity increased with the face as guide and shake reduced</td>
</tr>
<tr>
<td>$\text{Twilight using a tripod}$</td>
<td>Shoots with even slower shutter speed without increasing sensitivity</td>
</tr>
<tr>
<td>$\text{Backlight}$</td>
<td>Shoots with the brightness and contrast of the background adjusted (DROplus)</td>
</tr>
<tr>
<td>$\text{Backlight Portrait}$</td>
<td>Shoots with the brightness and contrast of the face and the background adjusted (DROplus)</td>
</tr>
</tbody>
</table>

* When flash is set to [Auto].

What is the Anti Blink function?

When set to [Advanced], the camera automatically shoots two images consecutively* when it recognizes $\text{Portrait}$ (Portrait). The camera will select, display, and record the image which the eyes are not blinked automatically. If the eyes are closed in both images, the message “Blinked eye detected” is displayed.

* except when the flash strobes/when the shutter speed is slow
Smile Detection Sensitivity

Sets the sensitivity of the Smile Shutter function for detecting smiles.

When you use DSC-T900, set the mode switch to  (Still image).

1. Lower the lens cover to switch to shooting mode.
2. MENU → (Smile Detection Sensitivity) → desired mode → OK

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Big Smile)</td>
<td>Detects a big smile.</td>
</tr>
<tr>
<td>(Normal Smile)</td>
<td>Detects a normal smile.</td>
</tr>
<tr>
<td>(Slight Smile)</td>
<td>Detects even a slight smile.</td>
</tr>
</tbody>
</table>

**Notes**

- Smiles may not be detected correctly depending on the conditions.
- You cannot select [Smile Detection Sensitivity] in EASY (Easy Shooting) or in Movie Mode.
- You can select only (High Sensitivity), (Soft Snap), (Twilight Portrait), (Beach), (Snow), and (Hi-Speed Shutter) in Scene Selection.
Face Detection

Selects whether to use the Face Detection function or not, and also selects the priority subject for adjusting the focus when using the function.
Detects the faces of your subjects and adjusts the focus, flash, exposure, white balance and red-eye reduction settings automatically.

![Face Detection frame (White)](image)

Face Detection frame (Orange)
When the camera detects more than one subject, the camera will judge which is the main subject and set focus by priority. The Face Detection frame for the main subject will turn orange. The frame for which the focus is set will turn green when the shutter button is pressed halfway down.

When you use DSC-T900, set the mode switch to (Still image).

1. Lower the lens cover to switch to shooting mode.
2. MENU → [ ] (Face Detection) → desired mode

![Menu Page](image)

- [ ] (When touched)
  Detects the face when an area with a face is touched on the screen.
- [ ] (Auto)
  Selects the face the camera is to automatically focus on.
- [ ] (Child Priority)
  Detects and shoots with priority on child’s face.
- [ ] (Adult Priority)
  Detects and shoots with priority on adult’s face.

### Notes
- [Face Detection] is fixed to [Auto] in EASY (Easy Shooting) or in Movie Mode.
- You can select [Face Detection] only when the Focus mode is set to [Multi AF] or the Metering Mode is set to [Multi].
- The Face Detection function does not work when using the digital zoom.
- Up to 8 faces of your subjects can be detected. However, only up to 4 faces of your subjects can be detected when [ ] (Soft Snap) mode is selected in the Scene Selection mode.
- Adults and children may not be recognized correctly depending on the conditions.
- During Smile Shutter shooting, [Face Detection] is automatically set to [Auto] even if it is set to [When touched].

### Choosing the priority subject
- Touch a subject to select it as the priority subject immediately, regardless of the Face Detection priority setting.
- When detecting multiple faces, the camera judges which is the main subject and adjusts the focus with priority on that subject. The Face Detection frame for the main subject is orange.
- When you press the shutter button halfway down, the Face Detection frames of subjects that are in focus turn green.
Making faces easier to detect

- Use an appropriate lighting level.
- Make sure the subjects’ faces are not hidden by hats, masks, sunglasses, etc.
- Make sure the subjects are facing the camera.
Flash Level

Adjusts the amount of flash light.

1. Lower the lens cover to switch to shooting mode.
2. 

3. 

Note

- Sometimes effects do not show up when the subject being shot is too bright or too dark.
**Anti Blink**

When Scene Selection is set to (Soft Snap) while you are shooting an image, the camera automatically shoots two images consecutively. The camera will select, display and record the image which the eyes are not blinked automatically.

1. Lower the lens cover to switch to shooting mode.
2. (REC Mode) → (Soft Snap) → OK
3. MENU → (Anti Blink) → desired mode →

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto</td>
<td>When Face Detection is active, the Anti Blink function operates so that images with the subject’s eyes open are recorded.</td>
</tr>
<tr>
<td>Off</td>
<td>Does not use the Anti Blink function.</td>
</tr>
</tbody>
</table>

**Notes**
- Anti Blink does not function in the following situations.
  - When using the flash
  - During burst or bracket shooting
  - When Face Detection function does not work
  - When the Smile Shutter function is activated
- Sometimes Anti Blink function does not work depending on the situation.
- When the Anti Blink function is set to [Auto] but only images with the subject’s eyes closed are recorded, the message “Blinked eye detected” is displayed on the LCD screen. Shoot again as necessary.
Red Eye Reduction

The flash strobes two or more times before shooting to reduce the red-eye phenomenon when using the flash.

1. Lower the lens cover to switch to shooting mode.
2. **MENU** → [Red Eye Reduction] → desired mode → **OK**

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ ] (Auto)</td>
<td>When the Face Detection function is activated, the flash strobes automatically to reduce the red-eye phenomenon.</td>
</tr>
<tr>
<td>[ ] On</td>
<td>The flash always strobes to reduce the red-eye phenomenon.</td>
</tr>
<tr>
<td>[ ] Off</td>
<td>Does not use Red Eye Reduction.</td>
</tr>
</tbody>
</table>

**Notes**

- You cannot select [Red Eye Reduction] when the camera is in **EASY** (Easy Shooting) mode, Movie Mode or Smile Shutter mode.
- To avoid blurring of images, hold the camera firmly until the shutter is released. It usually takes a second after you press the shutter button. Be also sure not to allow the subject to move during this period.
- Red Eye Reduction may not produce the desired effects. It depends on individual differences and conditions, such as distance to the subject, or if the subject looked away from the pre-strobe.
- If you do not use the Face Detection function, Red Eye Reduction does not work, even when you select [Auto].

💡 What causes the red-eye phenomenon?

Pupils become dilated in dark environments. Flash light is reflected off the blood vessels at the back of the eye (retina), causing the “red-eye” phenomenon.

Other ways to reduce red-eye

- Select [ ] (High Sensitivity) mode in Scene Selection. (The flash is turned [ ] (Flash Off) automatically.)
- When the eyes of the subject turn out red, correct the image with [Retouch] → [Red Eye Correction] on the viewing menu or with the supplied software “PMB”.

---

Red Eye Reduction
DRO

The camera analyzes the shooting scene and automatically corrects the brightness and contrast to improve the image quality. DRO stands for “Dynamic Range Optimizer”, a function that automatically optimizes the difference between the light and dark parts of an image.

1. Lower the lens cover to switch to shooting mode.
2. AUTO (REC Mode) → PGM (Program Auto) → OK
3. MENU → D-R (DRO) → desired mode → OK

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>D-R Off (Off)</td>
<td>Does not adjust.</td>
</tr>
<tr>
<td>✓ D-R (DRO standard)</td>
<td>Adjusts the brightness and contrast of the images automatically.</td>
</tr>
<tr>
<td>✓ D-R Plus (DRO plus)</td>
<td>Adjusts image brightness and contrast automatically and strongly.</td>
</tr>
</tbody>
</table>

**Notes**

- Depending on shooting conditions, it may not be possible to obtain correction effects.
- Only [ISO AUTO] or values from [ISO 80] to [ISO 800] can be set for the ISO value when [DRO plus] is set.
Color Mode

You can change the brightness of the image, accompanied by effects.

1. Lower the lens cover to switch to shooting mode.
2. `MENU` → `+` (Color Mode) → desired mode →

<table>
<thead>
<tr>
<th>Color Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Normal" /></td>
<td>Sets the image to standard color.</td>
</tr>
<tr>
<td><img src="image" alt="Vivid" /></td>
<td>Sets the image to bright and deep color.</td>
</tr>
<tr>
<td><img src="image" alt="Sepia" /></td>
<td>Sets the image to sepia color.</td>
</tr>
<tr>
<td><img src="image" alt="B &amp; W" /></td>
<td>Sets the image to black and white.</td>
</tr>
</tbody>
</table>

**Notes**

- You cannot select the Color Mode when the shooting mode is set to `AUTO` (Intelligent Auto Adjustment) mode or to any of the Scene Selection modes.
- You can select only [Normal], [Sepia] or [B & W] when shooting movies.
SteadyShot

Selects the anti-blur mode.

1. Lower the lens cover to switch to shooting mode.
2. MENU → (SteadyShot) → desired mode →

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>(Shooting)</td>
<td>Activates the anti-blur function when pressing the shutter button halfway down.</td>
</tr>
<tr>
<td></td>
<td>(Continuous)</td>
<td>Always activates the anti-blur function. You can stabilize images even when zooming up a far subject.</td>
</tr>
<tr>
<td></td>
<td>(Off)</td>
<td>Does not use anti-blur mode.</td>
</tr>
</tbody>
</table>

Notes

- In (Intelligent Auto Adjustment), EASY (Easy Shooting) mode or Scene Selection is set to (Gourmet) mode, [SteadyShot] is set to [Shooting].
- [SteadyShot] is fixed to [Continuous] while the Smile Shutter function is activated.
- For movies, you can set [Continuous] or [Off] only. The default setting for movies is set to [Continuous].
- The battery charge is used up more quickly in [Continuous] mode than in [Shooting] mode.
Hints for preventing blur

The camera moved accidentally when you took the image. This is called “Camera shake.” On the other hand, if the subject moved when you took the image, it is called “subject blur.” Besides, camera shake and subject blur occur frequently under low-light or slow shutter speed conditions, such as those encountered in (Twilight Portrait) or (Twilight) mode. In such case, shoot with the below tips in mind.

**Camera shake**

Your hands or body shake while you hold the camera and press the shutter button, and the entire screen is blurred.

- Use a tripod or place the camera on a flat surface to hold the camera steady.
- Shoot with a 2-second delay self-timer and stabilize the camera by holding your arms firmly at your side after pressing the shutter button.

**Subject blur**

Even though the camera is steady, the subject moves during the exposure so the subject looks blurred when the shutter button is pressed. Camera shake is reduced automatically using the anti-blur function. However, the function does not effectively reduce subject blur.

- Select (High Sensitivity) mode in Scene Selection.
- Select a higher ISO sensitivity to make the shutter speed faster, and press the shutter button before the subject moves.
Date List

This feature selects the date to be played back when using Date View. Step 2 is unnecessary when [Date View] is already set.

1. Press the (Playback) button to switch to playback mode.
2. MENU → (View Mode) → (Date View) → OK
3. MENU → (Date List) → OK
4. Select the month you want to display with ▲/▼ and select and touch the date.

Note

- This item is not displayed when the internal memory is used to record images.
Event List

This feature selects the event group to be played back when using Event View. You can enter a desired event name for each group using the “PMB” software (supplied). For details on entering the event name, see the “PMB Guide”. Step 2 is unnecessary when [Event View] is already set.

1. Press the (Playback) button to switch to playback mode.
2. MENU → (View Mode) → (Event View) → OK
3. MENU → (Event List) → OK
4. Select the event group you want to display with \+/→/→/→ and select and touch the event.

Note

- This item is not displayed when the internal memory is used to record images.
Select Folder

When multiple folders are created on a “Memory Stick Duo” media, this function selects the folder containing the image you want to play back.
Step 2 is unnecessary when [Folder View] is already set.

1 Press the (Playback) button to switch to playback mode.
2 MENU → (View Mode) → (Folder View) → OK
3 MENU → (Select Folder) → OK → select the folder with ↑/↓ → [OK]

Note
• This item is not displayed when the internal memory is used to record images.

Viewing images across multiple folders

When multiple folders are created and the first or last image in the folder is displayed, the following indicators appear.
➡️ Moves to the previous folder
➡️ Moves to the next folder
➡️ Moves to either the previous or next folders
View Mode

Allows you to select the display format for viewing multiple images.

1  Press the (Playback) button to switch to playback mode.

2  MENU → (View Mode) → desired mode →

✓  (Date View) Displays images by the date. Touch (Date List) to select a specific date with a calendar display.

(Click) (Event View) Analyzes the dates shots and frequency, automatically organizes the images into groups and displays them. Touch (Event List) to select the event group to view.

(Click) (Favorites) Displays images registered as Favorites. Touch the number of the Favorites you want to display.

(Click) (Folder View) Images are displayed, organized by folders. When a recording folder is already created, touch (Select Folder) to select a folder to view.

Notes
• When using the internal memory, the view mode is set to [Folder View].
• When images recorded with other cameras cannot be played back on this camera, view the images in [Folder View].

Viewing images taken with a different camera

If you insert into this camera a “Memory Stick Duo” media containing images taken both with this camera and another camera, a screen for selecting the playback method appears. “Playback only registered images” and “Playback all images with folder view”

If you select “Playback only registered images”, images are played back in the selected View Mode. Some images taken with other cameras may not be played back at this time.

If you select “Playback all images with folder view”, the View Mode is switched to Folder View and all images are played back.
On [Event View]

[Event View] is the function that the camera analyzes the dates shots and frequency, automatically organizes the images into groups and displays them. You can give convenient names to each event when using the supplied “PMB” software.

* No photo taken
Filter by Faces

This feature filters images and displays them.

1 Press the (Playback) button to switch to playback mode.

2  MENU ➔  (Filter by Faces) ➔ desired mode ➔  OK

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>(Off)</td>
<td>Images are not filtered.</td>
</tr>
<tr>
<td>(All people)</td>
<td>Images are filtered according to specified conditions and then displayed.</td>
</tr>
<tr>
<td>(Children)</td>
<td></td>
</tr>
<tr>
<td>(Infants)</td>
<td></td>
</tr>
<tr>
<td>(Smiles)</td>
<td></td>
</tr>
</tbody>
</table>

Notes

- This item is not displayed when the internal memory is used to record images.
- When the view mode is set to [Folder View], you cannot use the Filter by Faces function.
- Sometimes images are mistakenly displayed or hidden.
- Sometimes filtering cannot be performed with images shot using other cameras.
Add / Remove Favorites

Select your favorite image and add/remove from groups as Favorites. The 💌 mark is displayed for registered images.

**Notes**

- When the view mode is set to [Folder View], you cannot add or remove images as Favorites.
- This item is not displayed when the internal memory is used to record images.

**Registering the currently displayed image**

1. Press the ➤ (Playback) button to switch to playback mode.

2. Display the image you want to add as Favorites → **MENU** ➔ 💌 (Add / Remove Favorites) ➔ 💌 (This Image) ➔ **OK** ➔ touch the Favorites number to which you want to add the image ➔ [OK]

**Selecting and registering multiple images**

1. Press the ➤ (Playback) button to switch to playback mode.

2. **MENU** ➔ 💌 (Add / Remove Favorites) ➔ 💌 (Multiple Images) ➔ **OK** ➔ touch the Favorites number to which you want to add the image

3. Select images.

   **In single-image mode**
   ① Touch ►/◄ to display the image, then touch the image you want to add as Favorites.
   ② Repeat step ①.

   **In index mode**
   ① Touch ▲/▼ to turn the pages, then touch the image you want to add as Favorites.
   ② Repeat step ① to register more images.

4. ➔ ➔ [OK]

**Note**

- Touch an image with ✔ mark to release the ✔ mark.
Adding all images in the date range or event group

1. Press the (Playback) button to switch to playback mode.
2. **MENU** → (View Mode) → (Date View) or (Event View) → **OK**
3. Touch ▲/▼ to select the date or event you want to register.
4. **MENU** → (Add / Remove Favorites) → (Add All in Date Range) or (Add All in Event) → **OK** → touch the Favorites number to which you want to add the image → [OK]

Removing all images in the date range or event group

1. Press the (Playback) button to switch to playback mode.
2. **MENU** → (View Mode) → (Date View) or (Event View) → **OK**
3. Touch ▲/▼ to select a date or event for remove.
4. **MENU** → (Add / Remove Favorites) → (Remove All in Date Range) or (Remove All in Event) → **OK** → touch the Favorites number from which you want to remove the image → [OK]

Removing all images in Favorites

1. Press the (Playback) button to switch to playback mode.
2. **MENU** → (View Mode) → (Favorites) → **OK**
3. Select Favorites number for remove.
4. **MENU** → (Add / Remove Favorites) → (Remove All in Favorites) → **OK** → [OK]
Retouch

Adds effects or makes corrections to a recorded image and records it as a new file. The original image is retained.

1 Press the (Playback) button to switch to playback mode.

2 Menu → (Retouch) → desired mode → [OK]

3 Perform retouching according to the operation method in each mode.

.openHorizontalTable

<table>
<thead>
<tr>
<th>Method</th>
<th>Purpose</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Trimming)</td>
<td>Records the zoomed playback image.</td>
<td>Touch / set the point with ▲/ ▼/ → → select an image size to save with ▲/ ▼/ → [OK]</td>
</tr>
<tr>
<td></td>
<td>• The quality of trimmed images may deteriorate.</td>
<td>• The image size that you can trim may vary depending on the image.</td>
</tr>
<tr>
<td>(Red Eye Correction)</td>
<td>Corrects the red-eye phenomenon caused by flash.</td>
<td>After red eye correction is completed, touch [OK].</td>
</tr>
<tr>
<td></td>
<td>• You may not be able to correct the red-eye phenomenon depending on the image.</td>
<td></td>
</tr>
<tr>
<td>(Unsharp masking)</td>
<td>Sharpens the image within a chosen frame.</td>
<td>Touch the area (frame) of the desired image to retouch → → [OK]</td>
</tr>
<tr>
<td></td>
<td>• Depending on the image, sufficient correction may not be applied and the image quality may deteriorate.</td>
<td></td>
</tr>
<tr>
<td>(Soft Focus)</td>
<td>Blurs the periphery around a chosen point to signalize a subject.</td>
<td>Touch the center point of the desired image to retouch → → adjust the desired range to retouch with ▲/ ▼/ → select level of retouch with ▲/ ▼/ → → [OK]</td>
</tr>
</tbody>
</table>

Continued ↓
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Example Image</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Partial Color</strong></td>
<td>Surrounds a chosen point in monochrome to signalize a subject. Touch the center point of the desired image to retouch →  → adjust the desired range to retouch with [←/→] → [OK]</td>
<td><img src="image1.png" alt="Example Image" /></td>
</tr>
<tr>
<td><strong>Fisheye Lens</strong></td>
<td>Applies a fisheye effect around a chosen point. Touch the center point of the desired image to retouch →  → select level of retouch with [←/→] → [OK]</td>
<td><img src="image2.png" alt="Example Image" /></td>
</tr>
<tr>
<td><strong>Cross Filter</strong></td>
<td>Adds starburst effects to light sources. Adjust the desired length to retouch with [←/→] →  → select level of retouch with [←/→] → [OK]</td>
<td><img src="image3.png" alt="Example Image" /></td>
</tr>
<tr>
<td><strong>Radial Blur</strong></td>
<td>Decides the center point for expressing movement in the still image. Touch the center point of the desired image to retouch →  → adjust the desired range to retouch with [←/→] → [OK]</td>
<td><img src="image4.png" alt="Example Image" /></td>
</tr>
<tr>
<td><strong>Retro</strong></td>
<td>Softens the image by blurring the focus and lowering the surrounding light so that it appears as if it was taken by an old camera. Adjust the desired range to retouch with [←/→] →  → select the level of retouch with [←/→] → [OK]</td>
<td><img src="image5.png" alt="Example Image" /></td>
</tr>
<tr>
<td><strong>Happy Faces</strong></td>
<td>This feature puts a smile on a person’s face. Select the level of retouch with [←/→] → [OK]</td>
<td><img src="image6.png" alt="Example Image" /></td>
</tr>
</tbody>
</table>

**Note**

- You cannot retouch movies.

**Confirming retouching effects before saving images**

- You can confirm how a retouching effect will look (except for **Trimming** and **Red Eye Correction**)) by touching [Preview] while you are setting the effects.
Paint

Paints or adds stamps to a still image and records it as a new file.

1. Press the (Playback) button to switch to playback mode.
2. MENU → (Paint) → OK
3. Draw on the image using the paint pen (supplied).
4. Touch the button → select the saved image size → [OK]

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Save</td>
</tr>
<tr>
<td>2</td>
<td>Pen</td>
</tr>
<tr>
<td>3</td>
<td>Eraser</td>
</tr>
<tr>
<td>4</td>
<td>Stamp</td>
</tr>
<tr>
<td>5</td>
<td>Thickness/Stamps select</td>
</tr>
<tr>
<td>6</td>
<td>Color select</td>
</tr>
<tr>
<td>7</td>
<td>Exit</td>
</tr>
<tr>
<td>8</td>
<td>Frame</td>
</tr>
<tr>
<td>9</td>
<td>Revert</td>
</tr>
<tr>
<td>10</td>
<td>Clear all</td>
</tr>
</tbody>
</table>

Note
- You cannot paint or put stamps on movies.
Multi-Purpose Resize

You can change the aspect ratio and size of the shooting images, then record them as the new files.
You can convert images to the 16:9 aspect ratio for high definition viewing and to the VGA size for blog or e-mail attachments.

1 Press the (Playback) button to switch to playback mode.
2 MENU → (Multi-Purpose Resize) → desired mode → OK
3 Touch ▲/▼/◀/▶ to specify the area you want to trim → → [OK]

<table>
<thead>
<tr>
<th>(HDTV)</th>
<th>Changes the aspect ratio from 4:3/3:2 to 16:9 and saves as 2M size.</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Blog/E-mail)</td>
<td>Changes the aspect ratio from 16:9/3:2 to 4:3 and saves as VGA size.</td>
</tr>
</tbody>
</table>

**Notes**
- You cannot resize movies.
- You cannot convert images shot in the VGA size to (HDTV) size.
- Enlarging the image and multi resizing can reduce the image quality.
Delete

Allows you to select unwanted images for deletion.

Notes

- When using the internal memory, the view mode is set to [Folder View].
- You cannot delete images when the view mode is set to [Favorites].

Deleting the currently displayed image

1. Press the (Playback) button to switch to playback mode.
2. Display the image you want to delete → MENU → (Delete) → (This Image) → [OK]

Selecting and deleting multiple images

1. Press the (Playback) button to switch to playback mode.
2. MENU → (Delete) → (Multiple Images) → [OK]
3. Select images.
   - In single-image mode
     ① Touch / to display the image, then touch the image you want to delete.
     ② Repeat step ①.
   - In index mode
     ① Touch / to turn the pages, then touch the images you want to delete.
     ② Repeat step ① to delete more images.
4. → [OK]

Note

- Touch an image with mark to release the mark.

Deleting all images in the date range, event group or folder

1. Press the (Playback) button to switch to playback mode.
2. MENU → (View Mode) → (Date View), (Event View) or (Folder View) → [OK]
3. Touch / to select the date, event or folder you want to delete.
4. MENU → (Delete) → (All in Date Range), (All in Event) or (All in This Folder) → [OK]
Protect

Protects recorded images against accidental erasure. The  mark is displayed for registered images.

Note

- When using the internal memory, the view mode is set to [Folder View].

Protecting the currently displayed image

1 Press the  (Playback) button to switch to playback mode.

2 Display the image you want to protect → MENU →  (Protect) →  (This Image) → OK

Selecting and protecting multiple images

1 Press the  (Playback) button to switch to playback mode.

2 MENU →  (Protect) →  (Multiple Images) → OK

3 Select images.

   In single-image mode
   ① Touch ▶/◀ to display the image, then touch the image you want to protect.
   ② Repeat step ①.

   In index mode
   ① Touch △/▽ to turn the pages, then touch the images you want to protect.
   ② Repeat step ① to protect more images.

4 → [OK]

Note

- Touch an image with  mark to release the  mark.
Protecting all images in the date range, event group or folder

1 Press the (Playback) button to switch to playback mode.
2 MENU → (View Mode) → (Date View), (Event View) or (Folder View) → OK
3 Touch / to select the date, event or folder you want to protect.
4 MENU → (Protect) → (Set All in Date Range), (Set All in Event) or (Set All in This Folder) → OK → [OK]

Unlocking all images in the date range, event group or folder

1 Press the (Playback) button to switch to playback mode.
2 MENU → (View Mode) → (Date View), (Event View) or (Folder View) → OK
3 Touch / to select the date, event or folder you want to unlock.
4 MENU → (Protect) → (Remove All in Date Range), (Remove All in Event) or (Remove All in This Folder) → OK → [OK]

Protecting/unlocking all images in Favorites

1 Press the (Playback) button to switch to playback mode.
2 MENU → (View Mode) → ( Favorites) → OK
3 Select Favorites to set/unlock the protection.
4 MENU → (Protect) → (Set All in This Group) or (Remove All in Favorites) → OK → [OK]
DPOF

DPOF (Digital Print Order Format) is a function that allows you to specify the images of a “Memory Stick Duo” media that you want to print out later. The DPOF mark is displayed for registered images.

**Notes**
- The DPOF (Print order) mark cannot be added to movies or to images in the internal memory.
- You can add a DPOF (Print order) mark to a maximum 999 images.

**Order printing the currently displayed image**

1. Press the (Playback) button to switch to playback mode.
2. Display the image you want to order print →
   MENU → DPOF → DPOF (This Image) → [OK]

**Selecting and order printing multiple images**

1. Press the (Playback) button to switch to playback mode.
2. MENU → DPOF → DPOF (Multiple Images) → [OK]
3. Select images.
   - **In single-image mode**
     ① Touch ▶/◀ to display the image, then touch the image you want to order print.
     ② Repeat step ①.
   - **In index mode**
     ① Touch ▲/▼ to turn the pages, then touch the images you want to order print.
     ② Repeat step ① to order print more images.
4. [OK]

**Note**
- Touch an image with ✔ mark to release the ✔ mark.
Order printing all images in the date range, event group or folder

1. Press the (Playback) button to switch to playback mode.
2. MENU → (View Mode) → (Date View), (Event View) or (Folder View) → OK
3. Touch ✓/✓ to select the date, event or folder you want to order print.
4. MENU → DPOF (Set All in Date Range), DPOF (Set All in Event) or DPOF (Set All in This Folder) → OK → [OK]

Cancel print order of all images in the date range, event group or folder

1. Press the (Playback) button to switch to playback mode.
2. MENU → (View Mode) → (Date View), (Event View) or (Folder View) → OK
3. Touch ✓/✓ to select the date, event or folder you want to cancel.
4. MENU → DPOF → DPOF (Remove All in Date Range), DPOF (Remove All in Event) or DPOF (Remove All in This Folder) → OK → [OK]

Set/cancel print order of all images in Favorites

1. Press the (Playback) button to switch to playback mode.
2. MENU → (View Mode) → Favorites (Favorites) → OK
3. Select Favorites to set/cancel print order.
4. MENU → DPOF → DPOF (Set All in This Group) or DPOF (Remove All in Favorites) → OK → [OK]
Rotate

Rotates a still image. Use this function to display a horizontal orientation image in vertical orientation.

1. Press the (Playback) button to switch to playback mode.
2. MENU → (Rotate) → [OK]
3. [OK]

Notes

- You cannot rotate movies or protected still images.
- You may not be able to rotate images shot with other cameras.
- When viewing images on a computer, the image rotation information may not be reflected depending on the software.
Volume Settings

Adjusts the volume for slideshow and movie playback.

1 Press the ‡ (Playback) button to switch to playback mode.

2 MENU → ‡ (Volume Settings) → OK

3 Adjust the volume by touching ↓-/↑+ → [Exit]

💡 Adjusting the volume during playback of a movie or slideshow

**Movie playback:** Touch  vol to display the volume control screen, then touch the ↓-/↑+ buttons to adjust the volume. Touch [Exit] to turn off the volume control screen.

**Slideshow:** Touch the screen to display the volume control screen, then touch the ↓-/↑+ buttons to adjust the volume. Touch BACK to turn off the volume control screen.
Viewing an image on a SD TV (DSC-T900)

For details on using this function for DSC-T90, see pages 127 to 129.

You can view images recorded on the camera in standard picture quality by connecting the camera to an SD (Standard Definition) TV. The connection varies according to the type of TV the camera is connected to. See “TV TYPE” (page 69). Refer also to the operating instructions supplied with the TV.

1 Turn off both the camera and the TV.
2 Attach the camera to the multi-output stand (supplied).
3 Connect the multi-output stand to the TV using the AV Cable (supplied).

4 Turn on the TV and set the input.
5 Press (Playback) button to turn on the camera.

Images shot with the camera appear on the TV. Touch / displayed on the LCD screen of this camera to select the desired image.

Notes
- When you play back a single image, no icons are displayed on the TV.
- When using the camera abroad, it may be necessary to switch the video signal output to match that of your TV system (page 68).
- When you shoot movies in the condition where the camera and a TV are connected using an AV Cable, the image being shot is not displayed at the TV side.
Viewing an image on an HD TV (DSC-T900)

For details on using this function for DSC-T90, see pages 127 to 129.

You can view images recorded on the camera in high picture quality by connecting the camera to an HD (High Definition) TV using the HDMI Cable (sold separately) or HD Output Adaptor Cable (sold separately). The connection varies according to the type of TV the camera is connected to. See “TV TYPE” (page 69). Refer also to the operating instructions supplied with the TV.

1 Turn off both the camera and the HD TV.
2 Connect the camera to the TV using the HDMI Cable (sold separately) or HD Output Adaptor Cable (sold separately).

Notes

• When you play back a single image, no icons are displayed on the TV.
• Images shot in [VGA] image size cannot be played back in the HD format.
• When you shoot movies while the camera and a TV are connected using an HDMI Cable (sold separately), or HD Output Adaptor Cable (sold separately) the image being shot is not displayed on the TV.
• When using the camera abroad, it may be necessary to switch the video signal output to match that of your TV system (page 68).

Images shot with an image size other than the 16:9 (16:9 9M, 16:9 2M) full screen on an HD TV

• When you select [Multi-Purpose Resize] in the playback mode MENU, you can convert images to the 16:9 aspect ratio and save them as a new file for viewing on an HD TV.

On “PhotoTV HD”

This camera is compatible with the “PhotoTV HD” standard. By connecting a Sony TV compatible with “PhotoTV HD” using an HDMI Cable (sold separately) or HD Output Adaptor Cable (sold separately), a whole new world of photos can be comfortably enjoyed in breathtaking Full HD quality.
• PhotoTV HD allows for a highly-detailed, photo-like expression of subtle textures and colors.
• When the camera is connected to a Sony TV compatible with Video A mode using an HDMI Cable, your TV is automatically set to the picture quality suitable for still images. When the setting of the TV is set to Video, the picture quality is set to those suitable for movies.
• For details, see the operating instructions of the TV.
Viewing an image by connecting the camera to an HD TV using the HDMI Cable (sold separately)

Connect the camera to the HDMI terminal of an HD TV using the HDMI Cable (sold separately).

1. Attach the camera to the multi-output stand (supplied).
2. Connect the multi-output stand to the TV using the HDMI Cable (sold separately).

3. Turn on the TV and set the input.
4. Press  (Playback) button to turn on the camera.
   Images shot with the camera appear on the TV. Touch displayed on the LCD screen of this camera to select the desired image.

Notes
- Select HOME → (Settings) → [Main Settings] to select [Auto] or [1080i] for [HDMI Resolution].
- The beep sound is fixed to [Shutter].
- Do not connect the camera and equipment to be connected using output terminals. When the camera and TV are connected using output terminals, no video and sound are produced. Such a connection can also cause trouble of the camera and/or connected equipment.
- This function may not work properly with some HD TVs. For example, you may not be able to view a video on your HD TV or hear sound from the HD TV.
- Use an HDMI Cable with the HDMI logo.
Using “BRAVIA” Sync (Compatible with SYNC MENU)

When you use a TV that has “BRAVIA” Sync (compatible with SYNC MENU) support, you can operate the playback functions of the camera using the remote controller supplied with the TV by connecting the camera to the TV using the HDMI Cable (sold separately).

1. HOME → (Settings) → [Main Settings] → [CTRL FOR HDMI] → [On] → OK
2. Attach the camera to the multi-output stand (supplied).
3. Connect the multi-output stand to the TV using an HDMI Cable (sold separately).
4. Turn on the TV and set the input.
5. Press the " (playback) button of the camera to turn on the camera.
6. Press the SYNC MENU button of the TV’s remote controller to select the desired mode.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slideshow</td>
<td>Automatically plays back images with sound effects or background music in a continuous loop.</td>
</tr>
<tr>
<td>Single Image</td>
<td>Plays back a single image at a time.</td>
</tr>
<tr>
<td>Image Index</td>
<td>Displays multiple images at the same time.</td>
</tr>
<tr>
<td>Wide Zoom</td>
<td>Plays back 4:3 or 3:2 aspect ratio still images in 16:9 aspect ratio when you view a single image.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes recorded images.</td>
</tr>
<tr>
<td>Playback Zoom</td>
<td>Plays back enlarged images.</td>
</tr>
<tr>
<td>Rotate</td>
<td>Rotates a still image.</td>
</tr>
<tr>
<td>Filter by Faces</td>
<td>Filters (searches) images and display them.</td>
</tr>
<tr>
<td>View Mode</td>
<td>Selects the display format for viewing multiple images.</td>
</tr>
</tbody>
</table>

Notes

- When the camera is connected to a TV set using an HDMI Cable, the functions that you can operate are limited.
- When you touch the LCD screen of the camera while you operate the remote controller, the remote controller operation is temporarily interrupted.
- You can perform the operation of the camera with the remote controller of your TV by connecting your camera to a “BRAVIA” Sync compatible TV. For details, see the operating instructions of the TV.
- If the camera functions in an undesired manner when controlling with the TV’s remote controller, such as when connected via HDMI to another manufacturer’s TV, touch HOME and then select (Settings) → [Main Settings] → [CTRL FOR HDMI] → [Off].
Viewing an image by connecting the camera to an HD TV using the HD Output Adaptor Cable (sold separately)

Connect the camera to an HD (High Definition) TV using the HD Output Adaptor Cable (sold separately).
Use a Type2c-compliant HD Output Adaptor Cable.

1 Connect the camera to the TV using a HD Output Adaptor Cable (sold separately).

2 Turn on the TV and set the input.

3 Press (Playback) button to turn on the camera.
Images shot with the camera appear on the TV. Touch / on the LCD screen of the camera to select the desired image.

Note
- Before you use this function, select → (Settings) → [Main Settings] to select [HD(1080i)] for [COMPONENT].
On TV color systems

If you want to view images on a TV screen, you need a TV with a video input jack and the AV Cable. The color system of the TV must match that of the digital still camera. Check the following lists for the TV color system of the country or region where the camera is used.

**NTSC system**
Bahama Islands, Bolivia, Canada, Central America, Chile, Colombia, Ecuador, Jamaica, Japan, Korea, Mexico, Peru, Surinam, Taiwan, the Philippines, the U.S.A., Venezuela, etc.

**PAL system**
Australia, Austria, Belgium, China, Czech Republic, Denmark, Finland, Germany, Holland, Hong Kong, Hungary, Italy, Kuwait, Malaysia, New Zealand, Norway, Poland, Portugal, Singapore, Slovak Republic, Spain, Sweden, Switzerland, Thailand, United Kingdom, etc.

**PAL-M system**
Brazil

**PAL-N system**
Argentina, Paraguay, Uruguay

**SECAM system**
Bulgaria, France, Guiana, Iran, Iraq, Monaco, Russia, Ukraine, etc.
Viewing an image on a SD TV 
(DSC-T90)

For details on the operation of this function for DSC-T900, see pages 121 to 126.

You can view images recorded on the camera in standard picture quality by connecting the camera to an SD (Standard Definition) TV. The connection varies according to the type of TV the camera is connected to. See “TV TYPE” (page 69). Refer also to the operating instructions supplied with the TV.

1 Turn off both the camera and the TV.

2 Connect the camera to the TV with the cable for multi-use terminal (supplied).

![Diagram of cable connection]

3 Turn on the TV and set the input.

4 Press ▶️ (Playback) button to turn on the camera.

Images shot with the camera appear on the TV. Touch ▶️ displayed on the LCD screen of this camera to select the desired image.

Notes

- When the audio input jacks of the TV are stereophonic, connect the audio plug (black) of the cable for multi-use terminal to the left audio jack.
- When you play back a single image, no icons are displayed on the TV.
- When you shoot movies while the camera and a TV are connected using the cable for multi-use terminal (supplied), the image being shot is not displayed on the TV.
- When using the camera abroad, it may be necessary to switch the video signal output to match that of your TV system (page 68).
Viewing an image on an HD TV (DSC-T90)

For details on using this function for DSC-T900, see pages 121 to 126.

You can view images recorded on the camera in high picture quality by connecting the camera to an HD (High Definition) TV using the HDMI Cable (sold separately) or HD Output Adaptor Cable (sold separately). Use a Type1a-compliant HD Output Adaptor Cable. The connection varies according to the type of TV the camera is connected to. See “TV TYPE” (page 69). Refer also to the operating instructions supplied with the TV.

1 Turn off both the camera and the TV.
2 Connect the camera to the TV using a HD Output Adaptor Cable (sold separately).
3 Turn on the TV and set the input.
4 Press (Playback) button to turn on the camera.
   Images shot with the camera appear on the TV. Touch / displayed on the LCD screen of this camera to select the desired image.

Notes
• Before you use this function, select HOME ➔ (Settings) ➔ [Main Settings] to select [HD(1080i)] for [COMPONENT].
• When you play back a single image, no icons are displayed on the TV.
• Images shot in [VGA] image size cannot be played back in HD format.
• When you shoot movies in the condition where the camera and a TV are connected using an HD Output Adaptor Cable (sold separately), the image being shot is not displayed at the TV side.
• When using the camera abroad, it may be necessary to switch the video signal output to match that of your TV system (page 68).
• Purchase an HD Output Adaptor Cable that is compatible with your HD TV.
On TV color systems

If you want to view images on a TV screen, you need a TV with a video input jack and the cable for multi-use terminal. The color system of the TV must match that of the digital still camera. Check the following lists for the TV color system of the country or region where the camera is used.

**NTSC system**
Bahama Islands, Bolivia, Canada, Central America, Chile, Colombia, Ecuador, Jamaica, Japan, Korea, Mexico, Peru, Surinam, Taiwan, the Philippines, the U.S.A., Venezuela, etc.

**PAL system**
Australia, Austria, Belgium, China, Czech Republic, Denmark, Finland, Germany, Holland, Hong Kong, Hungary, Italy, Kuwait, Malaysia, New Zealand, Norway, Poland, Portugal, Singapore, Slovak Republic, Spain, Sweden, Switzerland, Thailand, United Kingdom, etc.

**PAL-M system**
Brazil

**PAL-N system**
Argentina, Paraguay, Uruguay

**SECAM system**
Bulgaria, France, Guiana, Iran, Iraq, Monaco, Russia, Ukraine, etc.
Enjoying your Windows computer

For details on using a Macintosh computer, refer to “Using your Macintosh computer” (page 139).

Install the software (supplied) first (page 132)

- Installing the software as follows:
  - “PMB”
  - “Music Transfer”

Connecting the camera to your computer (page 134)

- Enjoying images using “PMB” and “Music Transfer” as follows:
  - Importing images to your computer
  - Exporting images to the camera
  - Entering the desired event name to [Event List] on the camera
  - Editing images
  - Displaying the shooting locations of still images on maps online (this requires an Internet connection)
  - Creating a disc with the images shot (this requires CD or DVD disc writing drive)
  - Printing or saving still images with the date
  - Uploading images to a media service (this requires an Internet connection)
  - Changing Music for slideshow (using “Music Transfer”)

Additional information on this product and answers to frequently asked questions can be found at the Sony Customer Support Website.
http://www.sony.net/
**Recommended computer environment**

<table>
<thead>
<tr>
<th>For using “PMB” and “Music Transfer”</th>
<th>OS (pre-installed)</th>
<th>Others</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Microsoft Windows XP<em>1 SP3/Windows Vista</em>2 SP1</td>
<td>CPU: Intel Pentium III 800 MHz or faster (For playing/editing the High Definition movies: Intel Pentium 4 2.8 GHz or faster/Intel Pentium D 2.8 GHz or faster/Intel Core Duo 1.66 GHz or faster/Intel Core 2 Duo 1.20 GHz or faster)</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Memory</strong>: 512 MB or more (For playing/editing the High Definition movies: 1 GB or more)</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Hard Disk</strong>: Disk space required for installation—approximately 500 MB</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Display</strong>: Screen resolution: 1,024 × 768 dots or more</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Video memory</strong>: 32 MB or more (Recommended: 64 MB or more)</td>
</tr>
<tr>
<td>For importing images</td>
<td>Microsoft Windows 2000 Professional SP4, Windows XP<em>1 SP3/Windows Vista</em>2 SP1</td>
<td><strong>USB jack</strong>: Provided as standard</td>
</tr>
</tbody>
</table>

*1 64-bit editions and Starter (Edition) are not supported.
*2 Starter (Edition) is not supported.

**Notes**

- The computer environment must also satisfy the operating requirements of the OS.
- Operation is not assured in an environment based on an upgrade of the operating systems described above or in a multi-boot environment.
- Operations are not guaranteed for all the recommended computer environments mentioned above.
- If you connect two or more USB devices to a single computer at the same time, some devices, including the camera, may not operate, depending on the types of USB devices you are using.
- Operations are not guaranteed when using a USB hub.
- Connecting the camera using a USB interface that is compatible with Hi-Speed USB (USB 2.0 compliant) allows advanced transfer (high speed transfer) as the camera is compatible with Hi-Speed USB (USB 2.0 compliant).
- There are four modes for a USB connection when connecting a computer, [Auto] (default setting), [Mass Storage], [PictBridge] and [PTP/MTP] modes. This section describes the [Auto] and [Mass Storage] as examples. For details on [PictBridge] and [PTP/MTP], see page 70.
- When your computer resumes from a suspend or sleep mode, communication between the camera and your computer may not recover at the same time.
Installing the software (supplied)

You can install the supplied software (PMB, Music Transfer) using the following procedure.

1 Turn on your computer, and insert the CD-ROM (supplied) into the CD-ROM drive.
   The installation menu screen appears.
   • If it does not appear, double-click [Computer] (in Windows XP, [My Computer]) → (SONYPICUTIL).
   • If the AutoPlay screen appears, select “Run Install.exe.” and follow the instructions that appear on the screen to proceed with the installation.

2 Click [Install].
   The “Choose Setup Language” screen appears.

3 Select the desired language, then click [Next].
   The “License Agreement” screen appears.

4 Carefully read the agreement, click the radio button (◻ → ●) to accept the terms of the agreement, and then click [Next].

5 Follow the instructions on the screen to complete the installation.
   • When the restarting confirmation message appears, restart the computer following the instructions on the screen.
   • DirectX may be installed depending on the system environment of your computer.

6 Remove the CD-ROM after the installation is complete.
   The short cut icons for “PMB” and “PMB Guide” are created on the desktop.
   Double-click these icons to start the software.

Note
• Log on as Administrator.
On “PMB (Picture Motion Browser)”

You can use still images and movies from the camera more than ever by taking advantage of the software. This section summarizes the “PMB”. For details, see “PMB Guide”.

“PMB” overview

With the “PMB”:
• You can import images shot with the camera to the computer and display them on the computer.
• You can export images in your computer to the “Memory Stick Duo” media, and display them on the camera.
• You can enter the desired event name to [Event List] in the camera, and display them on the camera.
• You can organize images on the computer on a calendar by shooting date to view them.
• You can retouch (Red Eye Correction, etc.), search for faces, print, send still images as e-mail attachments, and change the shooting date.
• You can display information on the locations where you shot the images on a map. (This requires an Internet connection.)
• You can print or save the still images with the date.
• You can create a data disc using a CD burner drive or DVD burner drive.
• You can upload the image to a media service. (This requires an Internet connection.)

Starting the “PMB Guide”

1 Double-click the (PMB Guide) icon on the desktop.
To access “PMB Guide” from the Start menu, click [Start] → [All Programs] → [Sony Picture Utility] → [Help] → [PMB Guide].

Starting and exiting the “PMB”

1 Double-click the (PMB) icon on the desktop.
To access “PMB” from the Start menu, click [Start] → [All Programs] → [Sony Picture Utility] → [PMB].
The confirmation message of the Information tool appears on the screen when starting the “PMB” for the first time. Select [Start].
• This function informs you of news, such as software updates. You can change the setting later.
2 Click button on the top right corner of the screen to exit the “PMB”.

1 Double-click the (PMB Guide) icon on the desktop.
To access “PMB Guide” from the Start menu, click [Start] → [All Programs] → [Sony Picture Utility] → [Help] → [PMB Guide].
Enjoying images on your computer

For details on the “PMB” functions, see the “PMB Guide”.

Connecting the camera to the computer

When importing images in the internal memory, step 1 is unnecessary.

1. Insert a “Memory Stick Duo” media with recorded images into the camera.

2. DSC-T900:
   - Insert the sufficiently charged battery pack into the camera, or connect the multi-output stand to a wall outlet (wall socket) with the AC Adaptor (sold separately) and attach the camera to the multi-output stand.

   DSC-T90:
   - Insert the sufficiently charged battery pack into the camera, or connect the camera to a wall outlet (wall socket) with the AC Adaptor (sold separately) and the USB/AV/DC IN Cable for multi-use terminal (sold separately).
   - Use a Type 1a-compliant USB/AV/DC IN Cable.

3. Turn on the computer, then press (Playback) button.

4. Connect the camera to your computer.
   - “Connecting…” appears on the screen of the camera.
   - When a USB connection is established for the first time, your computer automatically runs a program to recognize the camera. Wait for a while.

   **Notes**
   - When you import/export images to your computer using a battery pack with little remaining charge, transferring may fail or image data may become corrupted if the battery pack shuts down too soon.
   - ’ is displayed on the screen during the communication session. Do not operate the computer while the indicator is displayed. When the indicator changes to , you can start using the computer again.
### Importing images to a computer

1. Make a USB connection between the camera and a computer.
   The [Import Media Files] screen of “PMB” appears automatically.
   - If the AutoPlay Wizard appears, close it.

2. Click the [Import] button to import images.
   The computer starts importing images.
   - By default, images are imported into a folder created in “Pictures” (in Windows XP, “My Pictures”) that is named with the event name of [Event List].

3. View images on your computer.
   When importing is complete, the “PMB” starts.
   Thumbnails of the imported images are displayed.
   - The “Pictures” (in Windows XP, “My Pictures”) folder is set as the default folder in “Viewed folders”.

### Viewing images using “PMB”

You can organize images on the computer on a calendar by shooting date to view them. For details on the “PMB”, see the “PMB Guide”.

### Importing images to a computer without using “PMB”

When the AutoPlay Wizard appears in step 1, click [Open folder to view files] → [OK] → [DCIM] → copy the desired images to the computer.
Exporting images to view on the camera

You can export images in your computer to the “Memory Stick Duo” media, and view them on the camera. This section describes the procedure for automatically selecting and exporting images that have not been exported to the “Memory Stick Duo” media in the camera.

You can also export the images manually. For details, see the “PMB Guide”.

1 Make a USB connection between the camera and a computer.
   If the AutoPlay Wizard appears, close it.
2 Double-click (PMB) on the desktop to start up “PMB”.
3 Click ☑ on the top of the screen.
   The easy export screen appears.
4 Click [Export].
   When you play back exported images on this camera, the ☑ mark is displayed on the LCD screen.

Notes
• You cannot play back some images depending on the image size.
• No guarantees are made for playing back, on this camera, files containing images which were processed on a computer or images which were shot using other cameras.
• This method cannot be used to export movies. Movies must be exported to the camera manually.

Deleting the USB connection

Perform the procedures from step 1 to 3 below before:
• Disconnecting the USB Cable (DSC-T900) or the cable for multi-use terminal (DSC-T90).
• Removing a “Memory Stick Duo” media.
• Inserting a “Memory Stick Duo” media into the camera after copying images from the internal memory.
• Turning off the camera.

1 Double-click the disconnect icon on the tasktray.
2 Click (USB Mass Storage Device) → [Stop].
3 Confirm the device on the confirmation window, then click [OK].
The image files recorded with the camera are grouped as folders on the “Memory Stick Duo” media or the internal memory.

A Folder containing image data recorded using a camera not equipped with the folder creating function.

B Folder containing still image data recorded using the camera.

C Folder containing movie data recorded using the camera.

Notes

• You cannot record any images to the “100MSDCF” or “100MNV01” folders. The images in these folders are available only for viewing.

• You cannot record/play back any images to the “MISC” folder.

• Image files are named as follows:
  – Still image files: DSC0[0-9][0-9][0-9][0-9].JPG
  – Movie files
    1280×720: M4H0[0-9][0-9][0-9][0-9].MP4
    VGA: M4V0[0-9][0-9][0-9][0-9].MP4
  – Index image files that are recorded when you record movies
    1280×720: M4H0[0-9][0-9][0-9][0-9].THM
    VGA: M4V0[0-9][0-9][0-9][0-9].THM

[0-9][0-9][0-9] stands for any number within the range from 0001 to 9999. The numerical portions of the name of a movie file recorded in Movie Mode and its corresponding index image file are the same.
Using the “Music Transfer” (supplied)

You can change the Music files that are preset at the factory to the desired Music files using “Music Transfer” in the CD-ROM (supplied). You can also delete or add these files whenever you want.

Changing Music using “Music Transfer”

The music formats you can transfer with “Music Transfer” are listed below:
• MP3 files stored on the hard disk drive of your computer
• Music on CDs
• Preset-music saved on the camera

1. HOME ➔ [Slideshow] ➔ [Music Tool] ➔ OK ➔ [Download Music]

   The message “Connect to PC” appears.

2. Make a USB connection between the camera and your computer.

3. Start “Music Transfer”.

4. Follow the instructions on the screen to change Music files.

💡 To restore the music preset at the factory to the camera

Execute [Restore to Preset Tracks] in step 4.
All Music files return to the preset-music, and [Music] in the [Slideshow] menu is set to [Mute].

• You can reset the Music files to the preset ones using [Initialize] (page 61), however, other settings will also be reset.
• For details on using “Music Transfer”, see the help in “Music Transfer”.
Using your Macintosh computer

You can copy images to your Macintosh computer. “PMB” is not compatible with Macintosh computers.
When images is exported to the “Memory Stick Duo” media, view them in the Folder View mode (page 50).

Recommended computer environment

<table>
<thead>
<tr>
<th>For copying images</th>
<th>OS (pre-installed)</th>
<th>Others</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Mac OS 9.1/9.2/</td>
<td>USB jack: Provided as standard</td>
</tr>
<tr>
<td></td>
<td>Mac OS X (v10.1 to v10.5)</td>
<td></td>
</tr>
<tr>
<td>For using “Music Transfer”</td>
<td>Mac OS X (v10.3 to v10.5)</td>
<td>Memory: 64 MB or more (128 MB or more is recommended)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Hard Disk: Disk space required for installation—approximately 50 MB</td>
</tr>
</tbody>
</table>

Notes

- Operations are not guaranteed for all the recommended computer environments mentioned above.
- If you connect two or more USB devices to a single computer at the same time, some devices, including the camera, may not operate depending on the types of USB devices you are using.
- Operations are not guaranteed when using a USB hub.
- Connecting the camera using a USB interface that is compatible with Hi-Speed USB (USB 2.0 compliant) allows advanced transfer (high speed transfer) as the camera is compatible with Hi-Speed USB (USB 2.0 compliant).
- There are four modes for a USB connection when connecting a computer, [Auto] (default setting), [Mass Storage], [PictBridge] and [PTP/MTP] modes. This section describes the [Auto] and [Mass Storage] as examples. For details on [PictBridge] and [PTP/MTP], see page 70.
- When your computer resumes from the suspend or sleep mode, communication between the camera and your computer may not recover at the same time.

Additional information on this product and answers to frequently asked questions can be found at the Sony Customer Support Website.
http://www.sony.net/
Importing and viewing images on a computer

When importing images in the internal memory, step 1 is unnecessary.

1. Insert a “Memory Stick Duo” media with recorded images into the camera.

2. DSC-T900:
   Insert the sufficiently charged battery pack into the camera, or connect the multi-output stand to a wall outlet (wall socket) with the AC Adaptor (sold separately) and attach the camera to the multi-output stand.

   DSC-T90:
   Insert the sufficiently charged battery pack into the camera, or connect the camera to a wall outlet (wall socket) with the AC Adaptor (sold separately) and the USB/AV/DC IN Cable for multi-use terminal (sold separately).
   • Use a Type Ia-compliant USB/AV/DC IN Cable.

3. Turn on the Macintosh computer, then press the (Playback) button on the camera.

4. Connect the camera to your Macintosh computer.

   **DSC-T900**

   ![Diagram of DSC-T900](image1)

   **DSC-T90**

   ![Diagram of DSC-T90](image2)

5. Double-click the newly recognized icon on the desktop → [DCIM] → the folder where the images you want to import are stored.

6. Drag and drop the image files to the hard disk icon.
   The image files are copied to the hard disk.
   • For details on the storage location of the images and file names, see page 137.

7. Double-click the hard disk icon → the desired image file in the folder containing the copied files.
Deleting the USB connection

Drag and drop the icon of the “Memory Stick Duo” media or the drive icon to the “Trash” icon beforehand when you perform the procedures listed below, or the camera is disconnected from the computer:
- Disconnecting the USB Cable (DSC-T900) or the cable for multi-use terminal (DSC-T90).
- Removing a “Memory Stick Duo” media.
- Inserting a “Memory Stick Duo” media into the camera.
- Turning off the camera.

Changing Music using “Music Transfer”

You can change the music files that are preset at the factory to the desired music files using “Music Transfer” in the CD-ROM (supplied). You can also delete or add these files whenever you want.

The music formats you can transfer with “Music Transfer” are listed below:
- MP3 files stored on the hard disk drive of your computer
- Music on CDs
- Preset-music saved on the camera

1. Turn on your Macintosh computer, and insert the CD-ROM (supplied) into the CD-ROM drive.
2. Double-click (SONYPICUTIL).
   The installation of the software starts.
4. HOME → (Slideshow) → [Music Tool] → OK → [Download Music] → OK
   The message “Connect to PC” appears.
5. Make a USB connection between the camera and Macintosh computer.
6. Start “Music Transfer”.
7. Follow the instructions on the screen to change music files.

Notes
- Shut down all other application software before you install “Music Transfer”.
- For installation, you need to log on as Administrator.

💡 Restoring the music preset at the factory to the camera

Execute [Restore to Preset Tracks] in step 7.
All Music files return to the preset-music, and [Music] in the [Slideshow] menu is set to [Mute].
- You can reset the Music files to the preset ones using [Initialize] (page 61), however, other settings will also be reset.
- For details on using “Music Transfer”, see the help in “Music Transfer”.
Viewing “Cyber-shot Step-up Guide”

“Cyber-shot Step-up Guide” further introduces how to use the camera and optional accessories.

**Viewing on Windows**

When you install “Cyber-shot Handbook”, “Cyber-shot Step-up Guide” is also installed.

1. Double-click (Step-up Guide) on the desktop.
   
   To access “Step-up Guide” from the Start menu, click [Start] → [All Programs] → [Sony Picture Utility] → [Step-up Guide].

**Viewing on Macintosh**

1. Copy the [stepupguide] folder in the [stepupguide] folder to your computer.

2. Select [stepupguide], [language] and then [GB] folder stored in the CD-ROM (supplied), and copy all the files in the [GB] folder to the [img] folder in the [stepupguide] folder that you copied to your computer in step 1. (Overwrite the files in the [img] folder with the files from the [GB] folder.)

3. After copying is complete, double-click “stepupguide.hqx” in the [stepupguide] folder to uncompress it, then double-click the generated file “stepupguide”.

**Note**

- If an uncompress tool for HQX file is not installed, install the Stuffit Expander.
Printing still images

You can print still images by the following methods.

**Printing directly using a PictBridge compliant printer (page 144)**

You can print images by connecting the camera directly to a PictBridge compliant printer.

**Printing directly using a “Memory Stick” media compliant printer**

You can print images with a “Memory Stick” media compliant printer. For details, see the operating instructions supplied with the printer.

**Printing using a computer**

You can import images to a computer using the supplied “PMB” software and print the images. You can insert the date on the image and print it. For details, see the “PMB Guide”.

**Printing at a shop (page 146)**

You can take a “Memory Stick Duo” media containing images shot with the camera to a photo printing service shop. You can make a DPOF (Print order) mark on the images which you want to print out in advance.

**Note**

- When you print images shot in [16:9] mode, both edges may be cut off.
Printing images directly using a PictBridge compliant printer

Even if you do not have a computer, you can print images shot using the camera by connecting the camera directly to a PictBridge compliant printer.

PictBridge “PictBridge” is based on the CIPA standard. (CIPA: Camera & Imaging Products Association)

Note
• You cannot print movies.

Preparing the camera

Prepare the camera for USB connection to the printer.

1 Insert the sufficiently charged battery pack into the camera.
2 Connect the camera to the printer.

DSC-T900

USB Cable
①To a USB jack of the printer
②To a USB jack
Multi-output stand (supplied)

DSC-T90

Cable for multi-use terminal
①To a USB jack of the printer
②To the multi connector

3 Turn on the printer, and press the (Playback) button.

After the connection is made, the indicator appears on the screen.
If the indicator flashes on the screen of the camera (error notification), check the connected printer.

Note
• If the connection between the camera and printer is not established, touch HOME ➔ (Settings) ➔ [Main Settings] ➔ [OK] ➔ [USB Connect] ➔ [OK] ➔ [PictBridge] ➔ [OK] and start over the procedure.
Printing

1. \text{MENU} \rightarrow \text{(Print)} \rightarrow \text{desired item} \rightarrow \text{OK}

\textbf{Printing the currently displayed image}
In single-image mode, select [This Image] as the desired item.

\textbf{Selecting and printing multiple images}
Select [Multiple Images] as the desired item.

\textbf{In single-image mode}
1. Touch \(\uparrow/\downarrow\) to display the image, then touch the image you want to print.
2. Repeat step 1.
3. \(\rightarrow\) [OK].

\textbf{In index mode}
1. Touch \(\leftarrow/\rightarrow\) to turn the pages, then touch the image you want to print.
2. Repeat step 1 to print more images.
3. \(\rightarrow\) [OK].

\textbf{Printing all images in the date range, event group, Favorites or folder}
In index mode, select [All in Date Range], [All in Event], [All in Favorites] or [All in This Folder] as the desired item, then touch [OK].

2. Touch the desired setting item to make the print settings.

\textbf{[Quantity]}
Selects the number of copies of the specified image to be printed.
- The designated number of images may not all fit onto a single sheet depending on the quantity of images.

\textbf{[Layout]}
Selects the number of images you want to print side by side on a sheet.

\textbf{[Size]}
Selects the size of the printing sheet.

\textbf{[Date]}
Selects [Day&Time] or [Date] to insert the date and time on images.
- When you choose [Date], the date will be inserted in the order you select (page 76). This function may not be provided depending on the printer.

3. Touch [OK].

The image is printed.
- Do not disconnect the USB Cable (DSC-T900) or the cable for multi-use terminal (DSC-T90) while the \(\leftarrow\) (PictBridge Connecting) indicator appears on the screen.
Printing at a shop

You can take a “Memory Stick Duo” media containing images shot with the camera to a photo printing service shop. As long as the shop supports photo printing services conforming to the DPOF, you can make a DPOF (Print order) mark on images in advance in the playback mode MENU so that you do not have to reselect them when you print them out at the shop.

Notes

- You cannot print images stored in the internal memory at a print shop directly from the camera. Copy the images to a “Memory Stick Duo” media, then take the “Memory Stick Duo” media to the print shop (page 57).
- Consult your photo printing service shop as to what types of a “Memory Stick Duo” media they handle.
- If a “Memory Stick Duo” media is not handled by your photo service shop, copy the images you want to print out to another medium such as a CD-R and take it to the shop.
- The “Memory Stick Duo” media Adaptor (sold separately) may be necessary. Consult your photo printing service shop.
- Before you take image data to a shop, always copy (back up) your data to a disk.
- You cannot set the number of prints.
- When you want to superimpose dates on images, consult your photo printing service shop.
Troubleshooting

If you experience trouble with the camera, try the following solutions.

1. **Check the items on pages 148 to 156.**
   If a code such as “C/E:□□:□□” appears on the screen, see page 157.

2. **Remove the battery pack, wait for about one minute, re-insert the battery pack, then turn on the power.**

3. **Initialize the settings (page 61).**

4. **Consult your Sony dealer or local authorized Sony service facility.**

On repairing cameras with internal memory or Music files function included, data in the camera may be checked on minimum necessity to verify and improve the malfunction symptoms. Sony will not copy or save any of those data.

Additional information on this product and answers to frequently asked questions can be found at our Customer Support Website.
http://www.sony.net/

Click one of the following items to move to the page explaining the symptom and cause or the appropriate corrective action.

- **Battery pack and power** ........... 148
- **Internal memory** ..................... 154
- **Shooting still images/movies** ...... 149
- **Printing** .............................. 154
- **Viewing images** ..................... 151
- **PictBridge compliant printer** ...... 154
- **Deleting** .............................. 152
- **Touch panel** .......................... 155
- **Computers** ............................ 152
- **Others** ................................. 156
- **“Memory Stick Duo” media** ........ 153
- **Warning indicators and messages** ................................. 157
Battery pack and power

Cannot insert the battery pack.
• Make sure the direction of the battery is correct, and insert it until the battery eject lever is locked.

Cannot turn on the camera.
• After inserting the battery pack into the camera, it may take a few moments for the camera to power up.
• Insert the battery pack correctly.
• The battery pack is discharged. Insert a charged battery pack.
• The battery pack is dead (page 165). Replace it with a new one.
• Use a recommended battery pack.

The power turns off suddenly.
• Depending on the camera and battery temperature, the power may turn off automatically to protect the camera. In this case, a message is displayed on the LCD screen before the power turns off.
• If you do not operate the camera for about three minutes while the power is on, the camera turns off automatically to prevent wearing down the battery pack. Turn on the camera again.
• The battery pack is dead (page 165). Replace it with a new one.

The remaining charge indicator is incorrect.
• The battery charge will get used up quickly and the actual remaining battery charge will be lower than the indicator in the following cases:
  – When you use the camera in an extremely hot or cold location.
  – When you use the flash and zoom frequently.
  – When you repeatedly turn the power on and off.
  – When [Brightness] of the DISP (screen display) is set to [Bright].
• A discrepancy arose between the remaining charge indicator and the actual remaining battery charge. Fully discharge the battery pack once, then charge it to correct the indication.
• The battery pack is discharged. Insert a charged battery pack.
• The battery pack is dead (page 165). Replace it with a new one.

Cannot charge the battery pack.
• You cannot charge the battery pack using the AC Adaptor (sold separately). Use the battery charger to charge the battery.

The CHARGE lamp flashes while charging the battery.
• Remove and reinser the battery pack, making sure it is installed correctly.
• The temperature may be inappropriate for charging. Try charging the battery pack again within the proper charging temperature range (10°C to 30°C (50°F to 86°F)).
• For details, see page 165.
Cannot record images.

- Check the free capacity of the internal memory or a “Memory Stick Duo” media. If it is full, do one of the following:
  - Delete unnecessary images (pages 43, 114).
  - Change the “Memory Stick Duo” media.
- You cannot record images while charging the flash.
- Switch the mode switch (DSC-T900 only).
- When shooting a still image, set the shooting mode other than  (Movie Mode) (DSC-T90 only).
- Set the shooting mode to  (Movie Mode) when shooting movies (DSC-T90 only).
- Movies with the size set to [1280×720] can only be recorded on a “Memory Stick PRO Duo” media. When using recording media other than a “Memory Stick PRO Duo” media, set the movie image size to [VGA].
- The camera is in Smile Shutter demonstration mode. Set [Demo Mode] to [Off].

Smile Shutter function does not work.

- No image is shot if a smiling face is not detected.
- [Demo Mode] is set to [On]. Set [Demo Mode] to [Off] (page 64).

The subject is not visible on the screen.

- The camera is set to the playback mode. Press  (Playback) button to switch to the shooting mode.

Anti-blur function does not work.

- The anti-blur function does not work when  appears on the display.
- The anti-blur function may not work properly when shooting night scenes.
- Shoot after pressing the shutter button halfway down; do not press it fully down suddenly.

Recording takes a long time.

- When the shutter speed becomes slower than a certain speed, for example, when you shoot images in dark locations, the camera automatically reduces the image noise. This function is called NR (noise reduction) slow shutter and the shooting time takes longer.
- The Anti Blink function is working. When [Anti Blink] is set to [Auto], reset to [Off] (page 96).

The image is out of focus.

- The subject is too close. When shooting, make sure to position the lens farther away from the subject than the shortest shooting distance (approximately 8 cm (3 1/4 inches) (W)/50 cm (19 3/4 inches) (T) from the lens). Or set to  (Close focus enabled) mode and shoot about 1 to 20 cm (13/32 to 7 7/8 inches) from the W side distance.
-  (Landscape) mode or  (Twilight) mode or  (Fireworks) mode is selected in the Scene Selection when shooting still images.
- The Semi manual function is selected. Select the auto focus mode (page 32).

Zoom does not work.

- You cannot use the Optical zoom in  (Close focus enabled) mode.
- You cannot use the Smart zoom depending on the image size (page 73).
- You cannot use the Digital Zoom when:
  - Shooting movies.
  - The Smile Shutter is working.
Cannot select the Face Detection function.
- You can select Face Detection only when the focus mode is set to [Multi AF] or the Metering Mode is set to [Multi].
- You cannot select Face Detection when the (Close focus enabled) mode is activated.

The flash does not work.
- You cannot use the flash when:
  - [REC Mode] is set to [Burst] or Exposure Bracket (page 81).
  - (High Sensitivity) mode or (Twilight) mode or (Fireworks) mode is selected in the Scene Selection.
  - Shooting movies.
- Set the flash to (Flash On) (page 31) in (Close focus enabled) mode or when the Scene Selection mode is set to (Landscape), (Gourmet), (Beach), (Snow), (Underwater) or (Hi-Speed Shutter).

Fuzzy white circular spots appear in images shot using the flash.
- Particles (dust, pollen, etc.) in the air reflected the flash light and appeared in the image. This is not a malfunction.

The close-up shoot function (Macro/Close focus enabled) does not work.
- (Landscape) mode or (Twilight) mode or (Fireworks) mode is selected in the Scene Selection.
- When (Close focus enabled) mode is selected, the shooting distance is approximately 1 to 20 cm (13/32 to 7 7/8 inches).
- You cannot select the [Macro On] mode when the camera is in Intelligent Auto Adjustment mode.
- Macro mode is set to [Auto] while shooting movies or when the Smile Shutter function is activated.

Macro shooting cannot be turned off.
- There is no function for forcibly turning off macro shooting. In (Auto) mode, you can shoot a distant subject even in the macro shooting condition.

The date and time are not displayed on the LCD screen.
- While shooting, the date and time are not displayed. They are displayed only during playback.

Cannot insert dates on images.
- This camera does not have a feature for superimposing dates on images. By using “PMB”, you can print or save images with the date (page 133).

The F value and shutter speed flash when you press and hold the shutter button halfway down.
- The exposure is incorrect. Correct the exposure (pages 36, 83).

The LCD screen is too dark or too bright.
- Adjust the brightness of the backlight (page 18).

The image is too dark.
- You are shooting a subject with a light source behind the subject. Select the metering mode (pages 34, 89) or adjust the exposure (pages 36, 83).
The image is too bright.
  • Adjust the exposure (pages 36, 83).

The image colors are not correct.
  • Set [Color Mode] to [Normal] (page 99).
  • Adjust the [White Balance] (page 85).

White, black, red, purple or other vertical streaks appear, or the whole screen of the image becomes reddish when you are shooting a very bright subject.
  • This is called “smear phenomenon”. This is not a malfunction.

Noise appears in the image when you view the screen in a dark place.
  • The camera is attempting to increase the visibility of the screen by temporarily brightening the image under conditions of low illumination. There is no effect on the recorded image.

The eyes of the subject come out red.
  • Shoot the subject at a distance closer than the flash range using the flash.
  • Light the room and shoot the subject.
  • Retouch the image using [Retouch] → [Red Eye Correction] in the playback mode MENU, or correct using “PMB”.

Dots appear and remain on the screen.
  • This is not a malfunction. These dots are not recorded.

Cannot shoot images in succession.
  • You cannot shoot images in succession while the Smile Shutter function is activated.
  • The internal memory or a “Memory Stick Duo” media is full. Delete unnecessary images (pages 43, 114).
  • The battery level is low. Insert charged battery pack.

The same image is shot several times.
  • [REC Mode] is set to [Burst] (page 81). Or, [Scene Recognition] is set to [Advanced] (page 90).

Viewing images

Cannot play back images.
  • Press [ ] (Playback) button.
  • The folder/file name has been changed on your computer.
  • No guarantees are made for playing back, on this camera, files containing images which were processed on a computer or images which were shot using other cameras.
  • The camera is in USB mode. Delete the USB connection (page 136)
  • You may not be able to play back some images stored on the “Memory Stick Duo” media shot using other cameras. Play such images in Folder View (page 50).
  • This is caused by copying images on your computer to the “Memory Stick Duo” media without using the “PMB”. Play such images in Folder View (page 50).
The date and time are not displayed.

- [Display Setup] is set to [Simple] or [Image Only]. Touch DISP to set [Display Setup] to [Normal] (page 17).

The image appears rough right after playback starts.

- This may happen due to image processing. This is not a malfunction.

Left and right sides of the screen are shown in black.

- [Auto Orientation] is set to [On] (page 74).

The buttons and icons no longer appear.

- If you touch the top right of the screen during shooting, the buttons and icons will momentarily disappear. The buttons and icons will reappear when you take your finger off the screen.
- [Display Setup] is set to [Image Only]. Touch DISP to set [Display Setup] to [Normal] or [Simple] (page 17).
- Touch the center of the screen during playback to display DISP, then select [Normal] or [Simple].

Cannot hear music during slideshow.

- Transfer music files to the camera with “Music Transfer” (page 138).
- Confirm that the volume setting and slideshow setting are correct (pages 41, 120).

The image does not appear on the TV.

- Check [Video Out] to see if the video output signal of the camera is set to the color system of your TV (page 68).
- Check whether the connection is correct (pages 121, 127).
- If the USB Cable (DSC-T900) or the cable for multi-use terminal (DSC-T90) is connected to the USB terminal, disconnect the cable (pages 136, 141).
- When you shoot movies in the condition where the camera and a TV are connected using the cable for multi-use terminal (DSC-T90 only), an HDMI Cable (sold separately) (DSC-T900 only) or HD Output Adaptor Cable (sold separately), the image being shot is not displayed at the TV side.

Deleting

Cannot delete an image.

- Cancel the protection (page 115).

Computers

Computer OS compatibility with camera is unknown.

- Check “Recommended computer environment” on page 131 for Windows, and page 139 for Macintosh.

A “Memory Stick PRO Duo” media is not recognized by a computer with a “Memory Stick” media slot.

- Check that the computer and the “Memory Stick” media Reader/Writer support a “Memory Stick PRO Duo” media. Users of computers and the “Memory Stick” media Readers/ Writers made by manufacturers other than Sony should contact those manufacturers.
- If a “Memory Stick PRO Duo” media is not supported, connect the camera to the computer (pages 134 and 140). The computer recognizes the “Memory Stick PRO Duo” media.
Your computer does not recognize the camera.
- When the battery level is low, insert the charged battery pack or use the AC adaptor (sold separately).
- Use the USB Cable (DSC-T900) or the cable for multi-use terminal (DSC-T90) for connection between the computer and the camera.
- Disconnect the USB Cable (DSC-T900) or the cable for multi-use terminal (DSC-T90) from both the computer and the camera, and firmly connect it again.
- Disconnect all equipment other than the camera, the keyboard and the mouse from the USB connectors of your computer.
- Connect the camera directly to your computer without passing through a USB hub or other device.

Cannot import images.
- Connect the camera and your computer correctly making a USB connection (page 134).
- When you shoot images with a “Memory Stick Duo” media formatted by a computer, you may not be able to import the images to a computer. Shoot using a “Memory Stick Duo” media formatted by the camera (page 53).

After making a USB connection, “PMB” does not start automatically.
- Make the USB connection after the computer is turned on.

Cannot play back images on your computer.
- If you are using “PMB”, refer to “PMB Guide” (page 133).
- Consult the computer or software manufacturer.

The image and sound are interrupted by noise when you view a movie on a computer.
- You are playing back the movie directly from the internal memory or the “Memory Stick Duo” media. Import the movie to the hard disk of your computer, then play back the movie from the hard disk (page 134).

Cannot print an image.
- Refer to the operation manual of the printer.

Images once exported to a computer cannot be viewed on the camera.
- Export them to a folder recognized by the camera, such as “101MSDCF” (page 137).
- When using software other than “PMB”, the information may not be updated correctly, so images may turn blue or otherwise not be displayed correctly. This is not a malfunction.
- When blue images appear, view them in the Folder View mode or delete them with the camera.

“Memory Stick Duo” media

Cannot insert a “Memory Stick Duo” media.
- Insert it in the correct direction.

You have formatted a “Memory Stick Duo” media by mistake.
- All the data on the “Memory Stick Duo” media is deleted by formatting. You cannot restore it.
Internal memory

Cannot playback or record images using the internal memory.
- There is a “Memory Stick Duo” media inserted in the camera. Remove it.

Cannot copy the data stored in the internal memory to a “Memory Stick Duo” media.
- The “Memory Stick Duo” media is full. Copy to a “Memory Stick Duo” media with sufficient capacity.

Cannot copy the data on the “Memory Stick Duo” media or the computer to the internal memory.
- This feature is not available.

Printing

See “PictBridge compliant printer” together with the following items.

Images are printed with both edges cut off.
- Depending on your printer, all the edges of the image may be cut off. Especially when you print an image shot with the image size set to [16:9], the lateral end of the image may be cut off.
- When printing images using your printer, cancel the trimming or borderless settings. Consult the printer manufacturer as to whether the printer provides these functions or not.
- When having images printed at a digital print shop, ask the shop whether they can print the images without cutting off both edges.

Cannot print images with the date.
- Using “PMB”, you can print images with date (page 133).
- The camera does not have a feature for superimposing dates on images. However, because the images shot with the camera include information on the recording date, you can print images with the date superimposed if the printer or the software can recognize Exif information. For compatibility with Exif information, consult the manufacturer of the printer or the software.
- If you use a photo printing service, ask them to superimpose the dates on images.

PictBridge compliant printer

A connection cannot be established.
- The camera cannot be connected directly to a printer that is not compliant with the PictBridge standard. Consult the printer manufacturer as to whether the printer is compliant with PictBridge or not.
- Check that the printer is turned on and can be connected to the camera.
- Set [USB Connect] to [PictBridge] (page 70).
- Disconnect the USB Cable (DSC-T900) or the cable for multi-use terminal (DSC-T90) and connect it again. If an error message is indicated on the printer, refer to the operating instructions supplied with the printer.
Cannot print images.
- Check that the camera and the printer are properly connected using the USB Cable (DSC-T900) or Cable for multi-use terminal (DSC-T90).
- Turn on the printer. For details, refer to the operating instructions supplied with the printer.
- If you select [Exit] during printing, images may not be printed. Disconnect the USB Cable (DSC-T900) or the cable for multi-use terminal (DSC-T90) and connect it again. If you still cannot print your images, disconnect the USB Cable (DSC-T900) or the cable for multi-use terminal (DSC-T90) once more, turn the printer off and then turn it on, and connect the cable again.
- Movies cannot be printed.
- Images shot using other cameras, or images modified with a computer may not be printed.

Printing is canceled.
- The USB Cable (DSC-T900) or the cable for multi-use terminal (DSC-T90) has been disconnected before the (PictBridge Connecting) indicator was turned off.

Cannot insert the date or print images in the index mode.
- The printer does not provide these functions. Consult the printer manufacturer as to whether the printer provides these functions or not.
- The date may not be inserted in the index mode depending on the printer. Consult the printer manufacturer.

“---- -- --” is printed on the date-inserted part of the image.
- The image does not have the recording data so the date cannot be inserted. Set [Date] to [Off] and print the image again (page 145).

Cannot select the print size.
- Consult the printer manufacturer as to whether the printer can provide the desired size.

Cannot print the image at the size selected.
- When you replace the printer paper with paper of a different size after connecting the printer to the camera, disconnect the USB Cable (DSC-T900) or the cable for multi-use terminal (DSC-T90) connected to the printer and then reconnect the printer.
- The print setting of the camera differs from that of the printer. Change the setting of either the camera (page 145) or the printer.

Cannot operate the camera after canceling printing.
- Wait for a while as the printer is carrying out the cancellation. It may take some time depending on the printer.

Touch panel

Cannot operate the touch panel buttons correctly or fully.
- Perform [Calibration] (page 62).
- [Housing] is set to [On] (page 63).

The paint pen operation reacts at inappropriate points.
- Perform [Calibration] (page 62).
The lens gets fogged.

- Moisture condensation has occurred. Turn off the camera and leave it for about an hour before using it.

The camera becomes warm when you use it for a long time.

- This is not a malfunction.

The Clock Set screen appears when you turn on the camera.

- Set the date and time again (page 76).
- The internal rechargeable backup battery has discharged. Insert a charged battery, and set aside for 24 hours or more with the power left off.

You want to change the date or time.

- Change the settings by \[HOME \rightarrow \hspace{1em} (Settings) \rightarrow [Clock Settings]\]
Warning indicators and messages

Self-diagnosis display

If a code starting with a letter of the alphabet appears, the self-diagnosis function on the camera is working. The last two digits (indicated by □□) will differ depending on the state of the camera.

If you cannot solve the problem even after trying the following corrective actions a few times, the camera may need repair.

Contact your Sony dealer or local authorized Sony service facility.

C:32:□□
  • There is trouble with the camera’s hardware. Turn the power off and on again.

C:13:□□
  • The camera cannot read or write data on the “Memory Stick Duo” media. Try turning off and on the camera again, or taking out and inserting the “Memory Stick Duo” media several times.
  • The internal memory has experienced a format error, or an unformatted a “Memory Stick Duo” media is inserted. Format the internal memory or the “Memory Stick Duo” media (page 53).
  • The inserted “Memory Stick Duo” media cannot be used with the camera, or the data is damaged.
    Insert a new “Memory Stick Duo” media.

E:61:□□
E:62:□□
E:91:□□
  • A camera malfunction has occurred. Initialize the camera (page 61), then turn the power on again.

Messages

If the following messages appear, follow the instructions.

⚠️
  • The battery level is low. Charge the battery pack immediately. Depending on the conditions of use or the type of battery pack, the indicator may flash even though there are still 5 to 10 minutes of remaining battery time left.

For use with compatible battery only
  • The battery inserted is not an NP-BD1 (supplied)/NP-FD1 (sold separately) battery pack.

System error
  • Turn the power off and then on again.
Camera overheating
Allow it to cool
• The camera temperature has risen. The power may turn off automatically, or you may be unable to record movies. Leave the camera in a cool location until the temperature goes down.

Internal memory error
• Turn the power off and then on again.

Reinsert the “Memory Stick”
• Insert the “Memory Stick Duo” media correctly.
• The inserted “Memory Stick Duo” media cannot be used in the camera (page 163).
• The “Memory Stick Duo” media is damaged.
• The terminal section of the “Memory Stick Duo” media is dirty.

“Memory Stick” type error
• The inserted “Memory Stick Duo” media cannot be used in the camera (page 163).

This “Memory Stick” may not record or play
• The inserted “Memory Stick Duo” media cannot be used in the camera (page 163).

Cannot access “Memory Stick”
Access denied
• You are using the “Memory Stick Duo” media with the access controlled.

Error formatting internal memory
Error formatting “Memory Stick”
• Format the media again (page 53).

“Memory Stick” locked
• You are using the “Memory Stick Duo” media with the write-protect switch, and the switch is set to the LOCK position. Set the switch to the recording position.

No memory space on internal memory
No memory space on “Memory Stick”
• Delete unnecessary images or files (pages 43, 114).

Read only “Memory Stick”
• The camera cannot record or delete images on this “Memory Stick Duo” media.

No images
• No images that can be played back have been recorded in the internal memory.
• No images that can be played back have been recorded in this folder of the “Memory Stick Duo” media.
• When images recorded with other cameras cannot be played back on this camera, view the images in Folder View mode (page 50).
No still images
• The selected folder does not contain a file that can be played back in a slideshow.
• There are no images that can be filtered by faces.

File found which was not recognized
• You tried to delete a folder containing a file that cannot be played on this camera. Delete the file on a computer and then delete the folder.

Folder error
• A folder with the same first three digit number already exists on the “Memory Stick Duo” media (for example: 123MSDCF and 123ABCDE). Select another folder, or create a new folder (pages 54, 55).

Cannot create more folders
• The folder with a name beginning with “999” exists on the “Memory Stick Duo” media. You cannot create any folders if this is the case.

Empty folder contents
• You tried to delete a folder containing one or more files. Delete all of the files and then delete the folder.

No folder
• You tried to delete a folder that does not exist.

Folder protected
• You tried to delete a folder that is protected as read only on a computer.

File error
• An error occurred while the image was playing back.
  No guarantees are made for playing back, on this camera, files containing images which were processed on a computer or images which were shot using other cameras.

Read only folder
• You have selected a folder that cannot be set as a recording folder on the camera. Select another folder (page 55).

File protected
• Release the protection (page 115).

Image size over limit
• You are playing back an image with size that cannot be played back on the camera.

Invalid operation
• You have touched the panel when using the digital zoom or Close focus enabled mode. While using these modes, you cannot focus by touching the screen.

Unable to detect face for retouch
• You may not be able to retouch the image depending on the image.
(Vibration warning indicator)

- Camera shake may occur due to insufficient light. Use the flash, turn on the anti-blur function, or mount the camera on a tripod to secure the camera.

1280x720 (Fine) is not available
1280x720 (Standard) is not available

- Only “Memory Stick PRO Duo” media is compatible of recording movies with an image size of [1280x720]. Use “Memory Stick PRO Duo” media or set the movie image size to [VGA].

Zoom disabled

- [Digital Zoom] is set to [Off] when you are shooting in  (Close focus enabled) mode. Or, you are trying to use [Smart] in [Digital Zoom] when the image size is set to [12M], [3:2(11M)] or [16:9(9M)] (page 73).

Maximum number of images already selected

- Up to 100 files can be selected when using [Multiple Images].
- Up to 999 files can be selected when using [All in Date Range], [All in Event], [All in Favorites] or [All in This Folder].
- Up to 999 files can be registered as Favorites, and you can add DPOF (Print order) marks to up to 999 files. Cancel the selection.

Low battery power

- When copying a image recorded in the internal memory to the “Memory Stick Duo” media, use a fully charged battery.

Printer busy
Paper error
No paper
Ink error
Low ink
No ink

- Check the printer.

Printer error

- Check the printer.
- Check if the image you want to print is corrupted.

The data transmission to the printer may not be completed yet. Do not disconnect the USB Cable (DSC-T900) or the cable for multi-use terminal (DSC-T90).

Processing...

- The printer is canceling the current print job. You cannot print until it is finished. This may take time, depending on the printer.

Error Playing Music

- Delete the Music file, or replace it with a normal Music file.
- Execute [Format Music], then download a new Music files.
Error Formatting Music

- Execute [Format Music].

Operation cannot be executed for movie files

- You have selected a function that is not available for movies.

Operation cannot be executed in unsupported files

- Processing and other editing functions of the camera cannot be performed on image files that have been processed using a computer or images that were recorded with other cameras.

Operation cannot be executed when using a PictBridge connection

- Some functions are restricted while the camera is connected to a PictBridge compliant printer.

Recovering image management file...

- The camera restores the date information etc. in cases where images have been deleted on a PC, etc.

- The number of images exceeds that for which date or event management by the camera is possible. Delete images from the Date View or Event View.

Image management file error

Cannot recover

- Import all of the images to the computer with “PMB”, and format the “Memory Stick Duo” media or the internal memory (page 53). When you cannot import all of the images to the computer with “PMB”, import all of the images to the computer without using “PMB” (page 135). To view the images again with the camera, export the imported images to the camera with “PMB”.

Recording function unavailable due to high internal temperature

- The camera temperature has risen. You cannot record images until the temperature has gone down.

Recording has stopped due to increased camera temperature

- Recording has stopped due to a rise in temperature while recording a movie. Please wait until the temperature goes down.

- When you record movies for a long time, the camera temperature rises. In this case, stop recording movies.
Using the camera abroad — Power sources

You can use the camera, the battery charger (supplied), and the AC-LS5K AC Adaptor (sold separately) in any country or region where the power supply is within 100 V to 240 V AC, 50/60 Hz.

**Note**

- Do not use an electronic transformer (travel converter), as this may cause a malfunction.
On the “Memory Stick Duo” media

A “Memory Stick Duo” media is a compact, portable IC recording medium. The types of “Memory Stick Duo” media that can be used with the camera are listed in the table below. However, proper operation cannot be guaranteed for all “Memory Stick Duo” media functions.

<table>
<thead>
<tr>
<th>“Memory Stick” media type</th>
<th>Recording/Playback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory Stick Duo (without MagicGate)</td>
<td>○*1</td>
</tr>
<tr>
<td>Memory Stick Duo (with MagicGate)</td>
<td>○*2</td>
</tr>
<tr>
<td>MagicGate Memory Stick Duo</td>
<td>○<em>1</em>2</td>
</tr>
<tr>
<td>Memory Stick PRO Duo</td>
<td>○<em>2</em>3</td>
</tr>
<tr>
<td>Memory Stick PRO-HG Duo</td>
<td>○<em>2</em>3*4</td>
</tr>
</tbody>
</table>

*1 High-speed data transfer using a parallel interface is not supported.
*2 “Memory Stick Duo” media, “MagicGate Memory Stick Duo” media and “Memory Stick PRO Duo” media are equipped with MagicGate functions. MagicGate is copyright protection technology that uses encryption technology. Data recording/playback that requires MagicGate functions cannot be performed with the camera.
*3 [1280×720] size movies can be recorded.
*4 This camera does not support 8-bit parallel data transfer. It performs the same 4-bit parallel data transfer as the “Memory Stick PRO Duo” media.

Notes

- This product is compatible with “Memory Stick Micro” media (“M2”). “M2” is an abbreviation for “Memory Stick Micro” media.
- A “Memory Stick Duo” media formatted with a computer is not guaranteed to operate with the camera.
- Data read/write speeds differ depending on the combination of the “Memory Stick Duo” media and the equipment used.
- Do not remove the “Memory Stick Duo” media while reading or writing data.
- Data may be corrupted in the following cases:
  - When the “Memory Stick Duo” media is removed or the camera is turned off during a read or write operation
  - When the “Memory Stick Duo” media is used in locations subject to static electricity or electrical noise
- We recommend backing up important data.
- Do not press down hard when you write down on the memo area.
- Do not attach a label on the “Memory Stick Duo” media itself nor on a “Memory Stick Duo” media Adaptor.
- When you carry or store the “Memory Stick Duo” media, put it in the case supplied with it.
- Do not touch the terminal section of the “Memory Stick Duo” media with your hand or a metal object.
- Do not strike, bend or drop the “Memory Stick Duo” media.
- Do not disassemble or modify the “Memory Stick Duo” media.
- Do not expose the “Memory Stick Duo” media to water.
- Do not leave the “Memory Stick Duo” media within the reach of small children. They might accidentally swallow it.
- Do not insert anything other than a “Memory Stick Duo” media into the “Memory Stick Duo” media slot. Doing so will cause a malfunction.
- Do not use or store the “Memory Stick Duo” media under the following conditions:
  - High temperature locations such as the hot interior of a car parked in direct sunlight
  - Locations exposed to direct sunlight
  - Humid locations or locations with corrosive substances present

Continued ↓
Notes on using the “Memory Stick Duo” media Adaptor (sold separately)

- To use a “Memory Stick Duo” media with a “Memory Stick” media compliant device, be sure to insert the “Memory Stick Duo” media into a “Memory Stick Duo” media Adaptor. If you insert a “Memory Stick Duo” media into a “Memory Stick” media compliant device without a “Memory Stick Duo” media Adaptor, you might not be able to remove it from the device.
- When inserting a “Memory Stick Duo” media into a “Memory Stick Duo” media Adaptor, make sure the “Memory Stick Duo” media is inserted facing in the correct direction, then insert it all the way in. Incorrect insertion may result in a malfunction.
- When using a “Memory Stick Duo” media inserted into a “Memory Stick Duo” media Adaptor with a “Memory Stick” media compliant device, make sure that the “Memory Stick Duo” media Adaptor is inserted facing the correct direction. Note that improper use may damage the equipment.
- Do not insert a “Memory Stick Duo” media Adaptor into a “Memory Stick” media compliant device without a “Memory Stick Duo” media attached. Doing so may result in malfunction of the unit.

Notes on using a “Memory Stick PRO Duo” media (sold separately)

A “Memory Stick PRO Duo” media with a capacity up to 16 GB have been confirmed to operate properly with the camera.

Notes on using a “Memory Stick Micro” media (sold separately)

- To use a “Memory Stick Micro” media with the camera, be sure to insert the “Memory Stick Micro” media into an “M2” Adaptor as large as of Duo size. If you insert a “Memory Stick Micro” media into the camera without an “M2” Adaptor as large as of Duo size, you might not be able to remove it from the camera.
- Do not leave the “Memory Stick Micro” media within the reach of small children. They might accidentally swallow it.

Notes on using the “Memory Stick Pro Duo” media Adaptor (sold separately)
On the battery pack

On charging the battery pack
- We recommend charging the battery pack in an ambient temperature of between 10°C to 30°C (50°F to 86°F). The battery pack may not be fully charged in temperatures outside this range.

Effective use of the battery pack
- Battery performance decreases in low temperature surroundings. So in cold places, the operational time of the battery pack is shorter. We recommend the following to ensure longer battery pack use:
  - Put the battery pack in a pocket close to your body to warm it up, and insert it in the camera immediately before you start shooting.
  - The battery pack will run out quickly if you use the flash or zoom frequently.
  - We recommend having spare battery packs handy for two or three times the expected shooting time, and making trial shots before taking the actual shots.
  - Do not expose the battery pack to water. The battery pack is not water-resistant.
  - Do not leave the battery pack in extremely hot places, such as in a car or under direct sunlight.

How to store the battery pack
- Fully discharge the battery pack before storing and store it in a cool, dry place. To maintain the battery pack’s function, fully charge the battery pack and then fully discharge it on the camera at least once a year while storing.
- To use the battery pack up, leave the camera in slideshow (page 41) playback mode until the power goes off.
- To prevent staining the terminal, short-circuiting, etc., be sure to use a supplied battery case when carrying and storing.

On battery life
- The battery life is limited. Battery capacity decreases over time and through repeated use. If decreased usage time between charges becomes significant, it is probably time to replace it with a new one.
- The battery life varies according to how it is stored and the operating conditions and environment in which each battery pack is used.

Compatible battery pack
- The NP-BD1 (supplied) can be used only in D type compatible Cyber-shot models. It cannot be used in Cyber-shot models compatible with the T type and other battery types.
- If you use the NP-FD1 battery pack (sold separately), the minutes also appear after the battery remaining indicator (60 Min).
On the battery charger

- Only D-type, T-type, R-type and E-type battery packs (and no others) can be charged in the battery charger (supplied). Batteries other than the specified kind may leak, overheat, or explode if you attempt to charge them, posing a risk of injury from electrocution and burns.
- The batteries that are compatible with this camera are D type batteries. The supplied battery is NP-BD1 (D type).
- Remove the charged battery pack from the battery charger. If you leave the charged battery pack in the charger, battery life may be shortened.
- When the CHARGE lamp flashes, remove the battery pack being charged, and then inserting the same battery pack into the battery charger again until it clicks. When the CHARGE lamp flashes again, this may indicate a battery error or that a battery pack other than the specified type has been inserted. Check that the battery pack is the specified type. If the battery pack is the specified type, remove the battery pack, replace it with new one or another one and check if the battery charger operates correctly. If the battery charger operates correctly, a battery error may have occurred.
## Index

### A

- Add / Remove Favorites ........................................... 108
- Adjusting EV .......................................................... 36, 83
- AF Illuminator ......................................................... 71
- AF range finder frame ............................................ 32
- Anti Blink .................................................................. 96
- Aperture .................................................................... 37, 83
- Auto Orientation ..................................................... 74
- Auto Review ............................................................. 75
- AV Cable .................................................................... 121

### B

- B & W ......................................................................... 99
- Battery charger ......................................................... 166
- Battery pack ............................................................. 165
- Beach ......................................................................... 21
- Beep .......................................................................... 59
- BRK ........................................................................... 82
- Burst .......................................................................... 81

### C

- Calibration .................................................................. 62
- Center AF .................................................................... 32
- Center-weighted metering ....................................... 34, 89
- Change REC.Folder ................................................... 55
- Changing the display ................................................ 17
- Clock Settings ............................................................ 76
- Close focus ............................................................... 30
- Color Mode ............................................................... 99
- COMPONENT ............................................................. 67
- Computer ................................................................... 130
  - Importing images .................................................. 135, 140
  - Macintosh ............................................................. 139
  - Windows .................................................................. 130
- Connecting
  - Computer ............................................................... 134
  - Printer ..................................................................... 144
  - TV ........................................................................... 121
- Copy ........................................................................... 57
- Create REC.Folder .................................................... 54
- Cross Filter .................................................................. 111
- CTRL FOR HDMI ...................................................... 66

### D

- Date........................................................................... 76, 145
- Date List ................................................................. 76, 145
- Date View ............................................................... 102
- Delete REC.Folder .................................................... 56
- Delete .......................................................................... 43, 114
- Demo mode .............................................................. 64
- Digital Zoom ............................................................ 73
- DirectX ........................................................................ 132
- DISP ........................................................................... 17
- Download Music ..................................................... 51
- DPOF .......................................................................... 117
- DRO ........................................................................... 98

### E

- Easy Shooting .......................................................... 23
- Electronic transformer ............................................ 162
- EV ............................................................................. 36, 83
- Event List ................................................................ 103
- Event View .............................................................. 48
- Exposure .................................................................... 37, 83
- Exposure Bracket ................................................... 82
- Extension .................................................................... 137

### F

- Face Detection .......................................................... 93
- Favorites .................................................................... 49
- File Number ............................................................. 58
- Filter by Faces .......................................................... 107
- Fireworks .................................................................... 21
- Fisheye Lens ............................................................. 111
- Flash Level ................................................................. 95
- Flash .......................................................................... 31, 80
- Focus .......................................................................... 32, 88
- Folder
  - Changing .................................................................. 55
  - Creating .................................................................... 54
  - Deleting .................................................................... 56
  - Selecting ................................................................... 104
- Folder View .............................................................. 50
- Format Music .......................................................... 52, 138
- Format ......................................................................... 53
- Function Guide .......................................................... 60
<table>
<thead>
<tr>
<th>G</th>
<th>Gourmet .................................................................21</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid Line .........................................................72</td>
<td></td>
</tr>
<tr>
<td>H</td>
<td>Happy Faces..........................................................111</td>
</tr>
<tr>
<td>HD(1080i) ...............................................................67</td>
<td></td>
</tr>
<tr>
<td>HDMI Resolution ......................................................65</td>
<td></td>
</tr>
<tr>
<td>High Sensitivity ......................................................21</td>
<td></td>
</tr>
<tr>
<td>Hi-Speed Shutter .....................................................22</td>
<td></td>
</tr>
<tr>
<td>Histogram ..................................................................18</td>
<td></td>
</tr>
<tr>
<td>HOME screen ..........................................................10</td>
<td></td>
</tr>
<tr>
<td>Housing .....................................................................63</td>
<td></td>
</tr>
<tr>
<td>I</td>
<td>Image Index .............................................................40</td>
</tr>
<tr>
<td>Image Size ...............................................................78</td>
<td></td>
</tr>
<tr>
<td>Initialize ..................................................................61</td>
<td></td>
</tr>
<tr>
<td>Install .......................................................................132</td>
<td></td>
</tr>
<tr>
<td>Intelligent Auto Adjustment .....................................20</td>
<td></td>
</tr>
<tr>
<td>Internal memory .......................................................19</td>
<td></td>
</tr>
<tr>
<td>ISO ...........................................................................35, 84</td>
<td></td>
</tr>
<tr>
<td>L</td>
<td>Landscape ..................................................................21</td>
</tr>
<tr>
<td>Language Setting ......................................................77</td>
<td></td>
</tr>
<tr>
<td>LCD Screen ..............................................................17</td>
<td></td>
</tr>
<tr>
<td>M</td>
<td>Macintosh computer ...............................................139</td>
</tr>
<tr>
<td>Macro .........................................................................30</td>
<td></td>
</tr>
<tr>
<td>Main Settings 1 .........................................................11</td>
<td></td>
</tr>
<tr>
<td>Main Settings 2 .........................................................11</td>
<td></td>
</tr>
<tr>
<td>Manage Memory .......................................................10</td>
<td></td>
</tr>
<tr>
<td>Mass Storage ............................................................70</td>
<td></td>
</tr>
<tr>
<td>“Memory Stick Duo” media ...........................................163</td>
<td></td>
</tr>
<tr>
<td>MENU ........................................................................12, 13</td>
<td></td>
</tr>
<tr>
<td>Menu screen ..............................................................12, 13</td>
<td></td>
</tr>
<tr>
<td>Metering Mode ..........................................................34, 89</td>
<td></td>
</tr>
<tr>
<td>Movie Mode ..............................................................46, 25</td>
<td></td>
</tr>
<tr>
<td>Movie shooting mode ..................................................26</td>
<td></td>
</tr>
<tr>
<td>MTP ...........................................................................70</td>
<td></td>
</tr>
<tr>
<td>Multi AF .....................................................................32, 88</td>
<td></td>
</tr>
<tr>
<td>Multi connector .........................................................121, 134, 140, 144</td>
<td></td>
</tr>
<tr>
<td>Multi-pattern metering ..............................................34, 89</td>
<td></td>
</tr>
<tr>
<td>Multi-Purpose Resize ................................................113</td>
<td></td>
</tr>
<tr>
<td>Music Tool ...............................................................10, 138</td>
<td></td>
</tr>
<tr>
<td>Music Transfer .........................................................138, 141</td>
<td></td>
</tr>
<tr>
<td>N</td>
<td>NTSC .........................................................................68</td>
</tr>
<tr>
<td>O</td>
<td>Optical zoom ...........................................................28, 73</td>
</tr>
<tr>
<td>OS .........................................................................131, 139</td>
<td></td>
</tr>
<tr>
<td>P</td>
<td>Paint .........................................................................112</td>
</tr>
<tr>
<td>PAL .............................................................................68</td>
<td></td>
</tr>
<tr>
<td>Partial Color ..............................................................111</td>
<td></td>
</tr>
<tr>
<td>PC ...........................................................................130</td>
<td></td>
</tr>
<tr>
<td>PictBridge .................................................................70, 144</td>
<td></td>
</tr>
<tr>
<td>Pixel ...........................................................................79</td>
<td></td>
</tr>
<tr>
<td>Playback .................................................................38, 39</td>
<td></td>
</tr>
<tr>
<td>Playback Zoom ..........................................................133</td>
<td></td>
</tr>
<tr>
<td>Precision digital zoom ............................................73</td>
<td></td>
</tr>
<tr>
<td>Print order mark .......................................................146</td>
<td></td>
</tr>
<tr>
<td>Print ...............................................................143</td>
<td></td>
</tr>
<tr>
<td>Printing directly .......................................................144</td>
<td></td>
</tr>
<tr>
<td>Program Auto ...........................................................24</td>
<td></td>
</tr>
<tr>
<td>Protect .................................................................115, 117</td>
<td></td>
</tr>
<tr>
<td>PTP ............................................................................70</td>
<td></td>
</tr>
<tr>
<td>R</td>
<td>Radial Blur .............................................................111</td>
</tr>
<tr>
<td>REC Mode .................................................................12, 81</td>
<td></td>
</tr>
<tr>
<td>Red Eye Correction ...................................................110</td>
<td></td>
</tr>
<tr>
<td>Red Eye Reduction .....................................................97</td>
<td></td>
</tr>
<tr>
<td>Retouch .................................................................110, 111</td>
<td></td>
</tr>
<tr>
<td>Retro .................................................................111, 119</td>
<td></td>
</tr>
<tr>
<td>Rotate .................................................................119</td>
<td></td>
</tr>
<tr>
<td>S</td>
<td>Scene Recognition .....................................................90</td>
</tr>
<tr>
<td>Scene Selection ........................................................21</td>
<td></td>
</tr>
<tr>
<td>Screen .................................................................17, 21</td>
<td></td>
</tr>
<tr>
<td>SD .................................................................67</td>
<td></td>
</tr>
<tr>
<td>Select Folder ............................................................104</td>
<td></td>
</tr>
<tr>
<td>Self-diagnosis display ..............................................157</td>
<td></td>
</tr>
<tr>
<td>Self-Timer ...............................................................29, 33</td>
<td></td>
</tr>
<tr>
<td>Semi manual ...........................................................33</td>
<td></td>
</tr>
<tr>
<td>Section</td>
<td>Page(s)</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Sepia</td>
<td>99</td>
</tr>
<tr>
<td>Settings</td>
<td>11</td>
</tr>
<tr>
<td>Shooting</td>
<td>20, 25</td>
</tr>
<tr>
<td>Shooting Settings 1</td>
<td>11</td>
</tr>
<tr>
<td>Shooting Settings 2</td>
<td>11</td>
</tr>
<tr>
<td>Shutter speed</td>
<td>37, 83</td>
</tr>
<tr>
<td>Slideshow</td>
<td>41</td>
</tr>
<tr>
<td>Slow Synchro (Flash On)</td>
<td>31</td>
</tr>
<tr>
<td>Smart zoom</td>
<td>73</td>
</tr>
<tr>
<td>Smile Detection Sensitivity</td>
<td>92</td>
</tr>
<tr>
<td>Smile Shutter</td>
<td>27</td>
</tr>
<tr>
<td>Snow</td>
<td>21</td>
</tr>
<tr>
<td>Soft Focus</td>
<td>110</td>
</tr>
<tr>
<td>Soft Snap</td>
<td>21</td>
</tr>
<tr>
<td>Software</td>
<td>132, 133, 138</td>
</tr>
<tr>
<td>Spot AF</td>
<td>32</td>
</tr>
<tr>
<td>Spot metering</td>
<td>34</td>
</tr>
<tr>
<td>SteadyShot</td>
<td>100</td>
</tr>
<tr>
<td>Temporarily Rotated Display</td>
<td>45</td>
</tr>
<tr>
<td>Touch panel</td>
<td>16</td>
</tr>
<tr>
<td>trimming</td>
<td>110</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>147</td>
</tr>
<tr>
<td>TV</td>
<td>121</td>
</tr>
<tr>
<td>TV TYPE</td>
<td>69</td>
</tr>
<tr>
<td>Twilight Portrait</td>
<td>21</td>
</tr>
<tr>
<td>Twilight</td>
<td>21</td>
</tr>
<tr>
<td>Underwater</td>
<td>22</td>
</tr>
<tr>
<td>Underwater White Balance</td>
<td>87</td>
</tr>
<tr>
<td>Unsharp masking</td>
<td>110</td>
</tr>
<tr>
<td>USB Connect</td>
<td>70</td>
</tr>
<tr>
<td>Using the camera abroad</td>
<td>162</td>
</tr>
<tr>
<td>VGA</td>
<td>78</td>
</tr>
<tr>
<td>Video Out</td>
<td>68</td>
</tr>
<tr>
<td>View Mode</td>
<td>105</td>
</tr>
<tr>
<td>Vivid</td>
<td>99</td>
</tr>
<tr>
<td>Volume Settings</td>
<td>120</td>
</tr>
<tr>
<td>Warning indicators and messages</td>
<td>157</td>
</tr>
<tr>
<td>White Balance</td>
<td>85</td>
</tr>
<tr>
<td>Zoom</td>
<td>28</td>
</tr>
</tbody>
</table>

**T**

- Temporarily Rotated Display: 45
- Touch panel: 16
- Trimming: 110
- Troubleshooting: 147
- TV: 121
- TV TYPE: 69
- Twilight Portrait: 21
- Twilight: 21

**U**

- Underwater: 22
- Underwater White Balance: 87
- Unsharp masking: 110
- USB Connect: 70
- Using the camera abroad: 162

**V**

- VGA: 78
- Video Out: 68
- View Mode: 105
- Vivid: 99
- Volume Settings: 120

**W**

- Warning indicators and messages: 157
- White Balance: 85

Wide Zoom: 18, 44
Windows computer: 130
Notes on the License

“C Library”, “Expat” and “zlib” software are provided in the camera. We provide this software based on license agreements with their owners of copyright. Based on requests by the owners of copyright of these software applications, we have an obligation to inform you of the following. Please read the following sections.
Read “license1.pdf” in the “License” folder on the CD-ROM. You will find licenses (in English) of “C Library”, “Expat” and “zlib” software.

THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO LICENSE FOR THE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) ENCODING VIDEO IN COMPLIANCE WITH THE MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO”) AND/OR (ii) DECODING MPEG-4 VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A PERSONAL AND NON-COMMERCIAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER LICENSED BY MPEG LA TO PROVIDE MPEG-4 VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. ADDITIONAL INFORMATION INCLUDING THAT RELATING TO PROMOTIONAL, INTERNAL AND COMMERCIAL USES AND/licensing may be obtained from MPEG LA, LLC. SEE HTTP://WWW.MPEGLA.COM

On GNU GPL/LGPL applied software
The software that is eligible for the following GNU General Public License (hereinafter referred to as “GPL”) or GNU Lesser General Public License (hereinafter referred to as “LGPL”) are included in the camera.
This informs you that you have a right to have access to, modify, and redistribute source code for these software programs under the conditions of the supplied GPL/LGPL.
Source code is provided on the web. Use the following URL to download it.
http://www.sony.net/Products/Linux/
We would prefer you do not contact us about the contents of source code.

Read “license2.pdf” in the “License” folder on the CD-ROM. You will find licenses (in English) of “GPL”, and “LGPL” software.
To view the PDF, Adobe Reader is needed. If it is not installed on your computer, you can download it from the Adobe Systems web page:
http://www.adobe.com/

On the license of “Music Transfer” in the CD-ROM (supplied)
MPEG Layer-3 audio coding technology and patents licensed from Fraunhofer IIS and Thomson.